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Abstract 
 

The Building Restoration Operations Optimization Model (BROOM) software 
system, developed by Sandia National Laboratories, is a comprehensive system 
designed to improve the efficiency and quality of sample collection, data 
management, and interpretation.  Currently, BROOM is capable of supporting 
sampling efforts at facilities contaminated with chemical and/or biological agents.  
BROOM provides advanced visualization, analysis, and sampling optimization 
functions, which speed up the sampling process and lower the associated sampling 
costs.  BROOM enables the user to develop a defensible sampling plan based on 
statistical analysis of sample results.  BROOM consists of two applications: one that 
runs on a hand-held PDA and one that runs on a Windows desktop/laptop.  This 
document covers the installation and basic operation of both components and 
provides examples of the application of these tools during and following an actual 
field exercise. 
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1. BROOM OVERVIEW 

The task of sampling a biologically or chemically contaminated facility is an immense one; 
thousands, if not tens of thousands, of samples must be collected, managed, and interpreted.  To 
date, there has been no comprehensive system for handling and assisting with this process.  The 
Building Restoration Operations Optimization Model (BROOM) software system was developed 
by Sandia National Laboratories (SNL) to meet this need.  BROOM improves the efficiency and 
quality of sample collection and data management, and additionally provides advanced 
visualization, analysis, and sampling optimization functions.  This cohesive set of features 
speeds up and lowers the costs of the sampling process. 
 
BROOM consists of two applications: one that runs on a hand-held PDA and one that runs on a 
Windows desktop/laptop.  Each provides the following functionality: 
 
PDA 

• Sample Collection 
Desktop 

• Data Management 
• Visualization 
• Analysis 
• Sampling Optimization 

 
1.1. Sample Collection 

BROOM’s PDA-based application improves the process of sample collection.  It will run on any 
Windows Mobile 4+ (6+ preferred) PDA, such as the Hewlett Packard iPAQ or Trimble Nomad.  
This application guides the sampling team to desired sampling locations and establishes accurate 
sample positions through the use of an innovative, patented, map-based laser range-finding 
system.  Simple, intuitive forms on the PDA guide the team through data entry of attributes, such 
as the collection method and characteristics of the sampled surface.  These forms and integrated 
barcode scanners eliminate the clerical errors inherent in paper-based systems and ensure the 
quality of the sample data.  Collected data are wirelessly transferred out of the contaminated area 
to a secure database and displayed on the desktop application, yielding instant updates for the 
field commanders.  The PDA also maintains close contact with the desktop application when 
possible, allowing the current locations of sampling teams to be tracked on the building maps. 
 
1.2. Data Management 

The desktop application provides a building model (floors, rooms, zones, etc.) in which sample 
data is stored and managed.  BROOM takes data management to the next level by intertwining 
the sample data with laboratory results, floor plans, ventilation schematics, aerial photographs, 
analysis, etc., to provide a comprehensive and descriptive data set. 
 
Management of this complex data is simplified through the use of convenient interfaces, such as 
a hierarchical project tree, spreadsheet-like data grids, and the building map itself.  This 
information is stored in a secure, industrial-strength Microsoft SQL Server relational database.  
While the full commercial version of SQL Server is recommended for full-scale deployments, 
BROOM is also compatible and distributed with the free scaled-down Microsoft SQL Server 
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Express (2005 or 2008).  The use of this database system allows secure, concurrent access by 
multiple users anywhere in the world. 
 
Furthermore, BROOM’s sample data are digital from the moment of creation, thus eliminating 
the multiple opportunities for data transcription and interpretation errors inherent in existing 
systems.  Likewise, laboratory results are received and imported electronically, again improving 
speed and data integrity.  The PDA and desktop applications also track the chain of custody of 
the sensitive and hazardous physical samples. 
 
1.3. Data Visualization 

A spreadsheet containing sample coordinates and laboratory results is not a practical 
representation of the overall picture.  Manually mapping these data is not desirable either, as this 
is a slow, inaccurate, and error-prone process. 
 
The centerpiece of BROOM’s data visualization system is the building map.  Samples are 
displayed on this map from the moment they are received from the PDA application.  These 
samples become color-coded once the laboratory results are received.  This color-coding can 
represent the raw quantity measured or the more intelligent surface contamination value, which 
normalizes sample values based on the sampled surface area and losses in the processes of 
collecting, extracting, and detecting the biological or chemical agent.  The building map also 
serves as the backdrop for insightful contamination and uncertainty maps generated by 
BROOM’s advanced analysis capabilities. 
 
Sample and analysis data can also be examined in BROOM’s 3D viewer.  This viewer allows 
samples and contamination maps to be experienced from the viewpoint of a person walking 
through the building, from a bird’s eye view, or anywhere in between with full 3D movement 
and viewpoint control. 
 
1.4. Analysis and Optimization 

Sample collection and laboratory analysis is an expensive and time-intensive process; reducing 
the number of samples is a primary goal of the BROOM system.  BROOM features many 
analysis capabilities designed to provide a comprehensive overall picture and optimize the 
number of required samples. 
 
The discrete data points of known samples can be analyzed to provide a continuous map of the 
contamination present in the facility.  Sample locations are proposed by BROOM through the 
combination of the contamination map with other analysis methods.  These proposed samples 
can be generated to achieve various goals, such as identifying hot spots, establishing the 
boundary of contamination, or minimizing overall uncertainty.  Proposed samples are then 
transferred to the PDA applications, which in turn guide the sampling teams in taking the next 
round of samples.  This iterative process of sampling and analysis both minimizes the number of 
samples and increases the confidence in the overall picture. 
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2. USER’S MANUAL OVERVIEW 

In this manual, the two software applications are commonly referred to as the “desktop 
application” and the “PDA application.”  The desktop application does not necessarily require a 
desktop computer—the term “desktop” can also refer to a laptop computer.  The term is used 
merely to distinguish it from the PDA application. 
 
The desktop application stores facility and sample information in a secure relational database.  
That database can be located on the same computer as BROOM or a server accessible via a 
network. 
 
This manual covers the process of installing both the desktop and PDA BROOM applications.  
Next, the manual shows how to create a project and import facility information.  Step-by-step 
instructions covering sample visualization, analysis, and data importing/exporting features 
follow.  A comprehensive tour of the PDA sample collection tool completes this hands-on guide. 
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3. INSTALLING BROOM 

This section of the manual will guide you through installation of the BROOM software.  You 
install the BROOM system from a CD.  First, you install BROOM on a desktop or laptop 
computer.  Then, if you choose, you may install BROOM onto a handheld PDA. 
 
3.1. System Requirements 

BROOM runs on most off-the-shelf computers.  Fully featured PDAs are used for sample data 
collection.  Administrator-level access is required for installation, but not necessarily for 
operation. 
 
3.1.1. Hardware 

BROOM operates on a desktop or laptop PC running the 32-bit Microsoft Windows XP, Vista, 
or Windows 7 operating system.  At this time, BROOM will not operate on 64-bit operating 
systems.  BROOM has been tested on systems having as little as 256 MB RAM memory.  The 
recommended minimum system configuration is: 
 

• Windows XP or Windows 7, running 32-bit system (will not run on 64-bit) 
• 2 GHz processor 
• 1 GB RAM 
• Monitor/video card supporting at least 1024x768 resolution and 16-bit color 
• At least 5 GB free space on the hard drive (particularly if hosting the SQL Server locally 

on the same machine) 
 
BROOM PDA software requires a PDA running the Windows Mobile 4.0 (or greater – version 6 
is preferred) operating system, 802.11 (b or g) wireless networking capability, Bluetooth wireless 
capability and either an integrated barcode scanner or an expansion slot that will accept a third-
party barcode scanner.  The PDA must have 64 MB of memory installed (128 MB is preferred).  
Installation instructions are tailored to the Trimble Nomad 800LE PDA as it is the preferred 
system. 
 
3.1.2. Windows User Privileges 

You must have Administrator user privileges to install BROOM on a computer.  Administrator 
privileges allow the BROOM installation routines to properly configure your computer to work 
with BROOM. 
 
3.1.2.1. Checking User Privileges 

If you do not know whether you have administrative privileges on your computer, you can check 
in five simple steps (Figure 3-1).  These steps pertain to Windows XP – if you are running Vista 
or Windows 7, you may need assistance from your tech support.  First, find the My Computer 
icon on your computer desktop and right-click on it.  This brings up a context menu at your 
mouse cursor.  Select Manage from the context menu and click with your left mouse button.  On 
left panel of the Computer Management dialog, open the Local Users and Groups folder, and 
then the Groups folder under that.   A list of groups appears in the right hand panel of the 



19 

Computer Management dialog.  Double click on the Administrators  item in the list.  The 
Administrators Properties dialog lists all users who have administrator privileges on your 
computer.  Check the list for the user name that you used to log into your computer.  If your user 
name shows up on that list, you have sufficient privileges to install BROOM.  Click the X 
buttons at the upper-right corner on the two dialogs to clear them from your screen. 

If you do not have Administrator privileges on your computer, do not proceed with BROOM 
installation.  Consult your system administrator about configuring your machine properly.  
Alternatively, you may consult your computer owner’s manuals or your Windows system 
documentation about how to configure your computer. 
 
3.2. Installing Desktop BROOM 

To install BROOM on a desktop or laptop computer you will simply run the installation program 
on the CD and follow the on-screen instructions. 

 
Figure 3-1.  Steps to Check for Administrator Privileges (Windows XP).  
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3.2.1. Installed Components  

 
The BROOM installation program installs the BROOM software as well as other software 
components that BROOM need in order to run.  Below is the list of components installed by the 
installation program, in the order of installation: 
 

• Microsoft .NET Framework 3.5 SP1 
• MapObjects 2.3 
• SQL Server 2008 R2 Express 
• Example SQL database 
• BROOM Desktop 

 
Microsoft .NET Framework 3.5 is included with Windows 7, but is included in the installer for 
installing on Windows XP. 
 
 
3.2.2. Starting the Installation Program Manually 

Start the installation program by following these steps: 
 

1. Right-click on the Windows Start button and select Explore. 
2. Navigate to your CD drive in the left panel and click on the drive. 
3. Now, in the right panel you should see all of the files in the root folder of the CD. 
4. Double click on the BROOM N.NN executable file (Error! Reference source not 

found.). 
 
Alternatively, you may use the Windows Command Prompt to run the installation program. 
 
After you launch the BROOM installer, you may not see anything on the screen right away.   Be 
patient.  It takes a few seconds for the installer to load into memory.  Disk activity will indicate 
that the installer is running 
 
* On Windows Vista or Windows 7, you will be prompted by User Account Control to allow the 
program to make changes to your computer.  Click Yes to proceed. 
 
The installation proceeds mostly without input from you.  You will see various progress bars and 
dialogs appearing.  Do nothing with them.  Your first input will be on the SQL Server 
installation screen. 
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Figure 3-2.  Starting the BROOM Installation. 
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3.2.3.  Continuing with Installation 

To continue with the installation of BROOM, enter a six-character password on the Microsoft 
SQL Server screen and then click the Next button.  The required SQL components will then be 
configured and installed on your system. 
 
 

 
After you have successfully installed SQL Server, you are prompted to install BROOM itself.  
Click the Next button on the Welcome screen. 

 
Figure 3-3.  SQL Server Installation Screen. 

 
Figure 3-4.  BROOM Installation Wizard Welcome screen. 
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On the subsequent screens, enter the requested information and click the Next button to proceed.  

 
Finally, click the Finish button when you see the screen “BROOM has been successfully 
installed”. 
 
**** Then REBOOT after the installation exits.  **** 
 
Rebooting restarts the SQL Server so BROOM can connect to a database. 
 
 

 
Figure 3-5.  BROOM successfully installed. 
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3.2.4. Installing the PDA software 

The BROOM PDA software is distributed as a .CAB file.  The BROOM PDA software depends 
on the Microsoft .NET Compact Framework and SQL Server Compact (SQL CE) software.  
These packages must be installed on the PDA before the BROOM software is installed.  These 
packages are also distributed as .CAB files.  All these files are included in the BROOM 
distribution CD.  The steps for installation are: 
 

1. Connect the PDA to the computer via a USB cable. 
2. If ActiveSync attempts to create a partnership, choose to create a Guest partnership. 
3. From your computer’s Start menu, select Run->Browse. 
4. In the Browse dialog, navigate to the CD drive. 
5. Open the BROOM PDA  folder of the BROOM distribution CD in the Browse dialog. 
6. Copy all the .CAB files from the CD to the PDA.  On the Trimble Nomad, the Storage 

Card is a good location. 
7. ON THE PDA, tap each of the following files, in this order, to install them: 

a.  NETCFv35.wm.armv4i.CAB 
b. sqlce.dev.ENU.wce5.armv4i.CAB 
c.  sqlce.repl.wce5.armv4i.CAB 
d. sqlce.wce5.armv4i.CAB 
e.  CAB Installer.CAB 

8. Tap OK if a dialog pops up saying “The previous version of XXX will be removed before 
the new one is installed…” 

9. Select “Device” if offered a choice of the location to install each package. 
 

4. USING THE DESKTOP APPLICATION 

This section of the manual leads you through starting the BROOM desktop application and 
shows how to use the major features of the system. 
 
4.1. Starting BROOM 

BROOM may be started by double-clicking on the desktop icon, if 
present (see Figure 4-1).  Alternatively, you can start BROOM from the 
Windows Start menu:  click Start > All Programs > Sandia National 
Laboratories > BROOM. 
 
4.2. The BROOM User Interface 

The BROOM interface is divided into multiple areas and control groups.  Figure 4-2 identifies 
each of these components described below: 
 

• The menu and main toolbar provide access to most BROOM functions. 

 
Figure 4-1.  BROOM 

Application Icon.  
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• The project tree provides hierarchical access to all levels of project data (project, 
buildings, floors, drawings, samples, analysis, etc.).  Most items in the project tree will 
display their properties in the property grid when selected.  Also, most items can be 
expanded to reveal their subitems by clicking the “+” to their left (or by double-clicking 
the item itself).  A building node in the project tree can be expanded to reveal its floors, 
for example. 

• The property grid displays the properties of the item currently selected in the project tree.  
The properties are unique and relevant to the type of item selected.  Some properties are 
editable, while others are read-only. 

• The status window displays messages pertaining to current activities—status reports on 
the various stages of loading a project, for example. 

• The map is the primary component of the BROOM interface.  This area provides the 
graphical representation of buildings (floor plans), samples, analysis maps, etc.  The map 
is composed of various layers whose visibility can be controlled by the checkboxes in the 
layer panel.  Some functions can be performed by right-clicking in the map area to open 
a context menu.  The items on this menu depend on the current map mode (as determined 
by the mode selected on the main toolbar). 

• The layer panel contains a list of checkboxes used to control the visibility of various map 
layers.  Checking a box makes the layer visible; unchecking a box hides the layer.  Some 
layers contain transparency while others are opaque.  Because of this, there may be times 
when you would like to rearrange the order of the layers.  This can be done by holding 
down the left mouse button and dragging the layer name to another position within the 
list. 

 
Figure 4-2.  BROOM Interface Layout. 
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4.3. Opening a Project 

A “project” is the fundamental grouping of data in BROOM.  A project contains one or more 
buildings and their associated data (maps, samples, etc.).  The Select Project form is the first 
thing to appear when BROOM is started (Figure 4-3).  This form allows you to create or open a 
project. 

 
Projects are stored in a database.  SQL Server is the Microsoft application that manages the 
database.  SQL Server may be running on your local computer or another computer on the 
network.  From here on, “SQL Server” may refer to a full-scale SQL Server installation or to the 
free Microsoft SQL Server Express that is distributed with BROOM. 
 
There are four steps involved in opening a project from a SQL Server database: 
 

1. Select the database login method (Login tab). 
2. Specify the name of the server (Database tab). 
3. Select the database on the server (Database tab). 
4. Select the project from the database (Project tab). 

 
The following sections describe these steps in greater detail. 
 
4.3.1. Select Project – Login Tab 

SQL Server requires the user to login to be able to access a database.  The Login tab is used to 
specify the database login method (Figure 4-4).  See Section Error! Reference source not 
found. for an explanation of the two login methods.  You must have an account on SQL Server 
you are attempting to login to, and that account must have permission to access the relevant 
BROOM database.  See Section 0 if you installed SQL Server on your local computer and are 
using it for the first time.  Otherwise, consult your system administrator if you are attempting to 
login to a SQL Server elsewhere on your network. 

 
Figure 4-3.  Select Project Form . 
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Every time you return to this form, it will remember the previously used login method.  If you 
are using the SQL Server Authentication method, it will remember the User Name but not the 
Password (for security reasons). 
 
4.3.2. Select Project – Database Tab 

The Database tab (Figure 4-5) allows you to specify the server and database to which you wish 
to connect.  The server is the computer on which SQL Server is running.  This may be your local 
computer or another computer on 
the network.  To connect to SQL 
Server running on your own 
computer, type “(local)” (without 
the quotes) in the Server box and 
click Connect.  To connect to SQL 
Server running on another 
computer, ask your system 
administrator for the server name 
and verify you have an account on 
it.  If you have previously opened a 
project, the Server box will 
remember the last-used server.  
You can also click on the box’s 
drop-down arrow to select from a 
list of recently used servers. 
 
There can be a 10 to 30-second 
delay if you attempt to connect to 

 
Figure 4-4.  Login Tab on the Select Project Form . 

 
Figure 4-5.  Database Tab on the Select Project Form . 
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an off-line or nonexistent server. 
 
Once you have connected to the server, the Database list on the form will display the databases 
on the server.  You will only see databases that you have access to (based on your login account).  
The list may be empty if no one has created a BROOM database yet.  If you need to create a 
database, click Cancel on this form, follow the steps in Section 4.4, and then return to this form 
by selecting File > Open Project on the main menu. 
 
If there are one or more databases listed, select a database (click on the name) then click on the 
Project tab. 
 
There can be non-BROOM databases on the server.  The form will alert you if you attempt to 
select a non-BROOM database. 
 
4.3.3. Select Project – Project Tab 

The Project tab allows you to select an existing project or create a new project.  Select an 
existing project from the list or select Create new project and enter a project Name.  At this 
point, the OK  button will become enabled.  Click OK  to open or create the project. 

 
4.4. Creating a Database 

Before you can create a project, you must have a database in which to save it.  Follow these steps 
to create a new database: 
 

 
Figure 4-6.  Project Tab on the Select Project Form . 
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1. From the main menu, select Data > Database > Create New Database.  This will open 
the Create New Database form shown in Figure 4-7. 

2. Enter a name for the new database in the Database Name textbox. 
3. Unless otherwise instructed by your system administrator, leave Use Default 

Characteristics checked. 
4. Enter the name of the Server where you would like to create the database.  See Section 

4.3.2 for help determining the server name. 
5. Select the login method (Windows Authentication or SQL Server Authentication) for 

the SQL Server account that will be used to create the database.  This account must have 
permission to create databases (must be a system administrator within the SQL Server or 
a member of the “dbcreate” group).  See Section Error! Reference source not found. or 
consult your system administrator for help with this. 

6. Click OK  to create the database. 
 
It may take a moment for the database to be created.  If successful, you will see a Database 
Created message appear. 
 
You can now create a new project in this database by selecting File > New Project from the 
main menu.  See Section 4.2 for further help with creating or opening a project. 
 

 
Figure 4-7.  Form for Creating a Database . 
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4.5. Project Properties 

As mentioned in Section 4.2, selecting an item in 
the project tree loads the item’s properties into the 
property grid.  By selecting the project in the tree 
(topmost node), you can edit the project’s name and 
temporary file directories (Figure 4-8).  You can 
change the project name at any time.  The 
DrawingFileFolder and ShapeFileFolder determine 
where BROOM will store temporary graphics files 
on your computer. 
 
 
 
 
 
4.6. Creating a Building 

A new project is initially empty.  The first thing to do is create a building.  To add a new 
building to the project, click the Add Building  button above the project tree (Figure 4-9).  The 
new building name will default to “Building 1,” however, you can rename this building by 
clicking on it in the tree and then editing the Name in the property grid near the bottom-right of 
the window.  New buildings are empty; you must now define some floors for this building. 

 
4.6.1. Adding Floors to a Building 

A new building is initially empty.  You must add one or more floors by clicking the Add Floor 
button (Figure 4-11).  A new floor will appear under the building in the project tree (Figure 
4-12).  The first new floor will have a default name of “Floor 1.”  You can rename the floor by 
editing its Name in the property grid.  Expand the floor node in the tree (click the “+”to its left) 
and notice all of the items that belong to a floor (drawings, samples, room, etc.). 
 
To make a floor useful, the next step is to add a drawing for the floor. 

 
Figure 4-8.  Project Property Grid . 

 
Figure 4-9.  Add Building 

Button. 

 
Figure 4-10.  New Building 

in Project. 
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4.6.2. Adding a Drawing to a Floor 

A new floor initially has no graphical representation of its layout.  For a floor to be meaningful 
and useful, a drawing (i.e., a floor plan) must be assigned to the floor.  This drawing will appear 
in the map area and provide the basis for locations of items such as samples.  A drawing can be 
anything from a highly detailed architectural CAD file to a scanned-in pencil-and-paper sketch 
of the floor plan.  A floor can have any number of drawings, which can be selectively shown or 
hidden via the checkboxes in the layer panel to the left of the map. 
 
BROOM supports the following file formats: 

• AutoCAD® drawings (.dwg, .dxf) 
• MicroStation® CAD drawings (.dwg, .dgn) 
• JPEG images (.jpg) 
• GIF images (.gif) 
• Bitmap images (.bmp) 
• Shapefiles (.shp) 

 
There are several ways to add a drawing to a floor: 

• Right-click on the floor node in the project tree and select Add Drawing. 
• Or, right-click on a floor’s drawing folder in the project tree and select Add. 
• Or, on the main menu, select Floor > Add Drawing. 

 
Any of these methods will open a window that allows you to browse for and select a drawing 
file.  For the case of a CAD drawing, the preference is a .dxf file.  Once the file is selected the 
user is prompted to identify the base scale for the CAD drawing, whether it is in inches, feet, or 
meters, as shown in Figure 4-13. The dialog also allows the user to set an offset to the coordinate 
system and to rotate the image, if desired. 
 

 
Figure 4-11.  Add Floor 

Button. 

 
Figure 4-12.  New Floor in a 

Building. 
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Figure 4-13.  The CAD import dialog. 
 
Once imported, the CAD drawing will look something like Figure 4-14. 
 

 
 

Figure 4-14.  A CAD drawing in the BROOM system. 
 
To bring in the bitmap imagery (e.g., jpg, bmp, etc.), the user needs to establish a point of 
reference to register the drawing to in order to establish the appropriate scale of the drawing.  In 
the case of bringing a bitmap image of a CAD drawing it is relatively easy to make match points 
between the two drawings.  If no CAD drawing exists, then a polygon of known dimensions 
should be input as a room and the bitmap image register to it.  This polygon could be a 
rectangular room, for instance.  Once the registration has taken place, the polygon could be 
erased. 
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The process of bringing in the bitmap image to register it begins with selecting the Add option 
under the Building > Floor > Drawings option in the right hand pane and selecting the 
appropriate drawing.  A pop-up window will appear with the image of the main screen and the 
bitmap image that is to be imported.  Figure 4-15 shows an example of this fitting registration 
where the user controls the pan and zoom features to accurately position two match points, a 
green and a red on both screens. 
 

 
 

Figure 4-15. Registering a bitmap drawing to another map or image. 
 
Once the registration process is completed, the user clicks OK and the image will be stored at the 
appropriate scale. 
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4.7.  Adding Rooms to a Floor 

Rooms are polygons on the map that represent the outlines of rooms.  Rooms occupy their own 
map layer and are overlaid onto the floor’s drawings (see Section 4.6.2).  You can draw rooms 
using the CAD file or bitmap image as background for guidance.  If you do not have CAD or 
bitmap files for a building, you can use the room drawing tools to generate rooms in the building. 
 
4.7.1. Rectangular Rooms 

To begin drawing rectangular rooms on the map, click the add rectangular rooms button on the 
main toolbar (Figure 4-16).  This sets the current map 
interaction mode for drawing rooms.  Now, whenever 
you click your mouse within the map area, BROOM will 
interpret your action as an intention to draw rooms on the 
map. 
 
To draw a rectangular room, determine the location on 
the map where you want one corner of the room.  Then, 
while holding the left mouse button down, drag the cursor to the location on the map where you 
want the opposite corner of the room to be.  When you release the mouse button, BROOM will 
draw a blue rectangle room at the location you specified. 
 
Sometimes it may be difficult to click exactly on the corner of the room (on the underlying map 
image) where you want the room to begin.  If you have a CAD drawing visible, you can tell 
broom to use corner snapping to make room drawing more accurate.  Corner snapping means 
that you can click your 
mouse close to a corner on 
the CAD drawing and 
BROOM will adjust the 
point you selected to be 
exactly the point in the 
corner of the CAD drawing.  
This makes the rooms as 
accurate as the CAD 
drawings and improves the 
speed and ease of creating 
rooms. 
 
To enable corner snapping, 
select View > View 
Options on the main menu.  
This brings up the window shown in Figure 4-17.  Select the Building Geometry folder at the 
left.  A check mark next to Snap to Corners indicates corner snapping is active.  Clicking this 
checkbox with the left mouse button will toggle corner snapping on and off. 
 
As you add rooms to the building map, notice that the individual rooms are also added to the 
project tree under the Rooms folder of the current floor. 

 
Figure 4-16. 

Add Rectangular Rooms Button. 

 
Figure 4-17. 

Corner Snapping Option.  
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4.7.2. Polygonal Rooms 

Most rooms in can be drawn as simple rectangle.  However, some rooms have walls at odd 
angles or are more complex than a simple rectangle. 
 
The polygonal room mode is used to draw irregularly shaped rooms.  To draw polygonal rooms, 
left-click the add polygonal rooms button on the main toolbar (Figure 4-18). 

 
Now you are in polygonal room drawing mode.  You can create rooms 
by simply clicking the corners of a room in sequence (Figure 4-19).  To 
complete a room, double-click the mouse and BROOM will connect all 
the corners you have marked and construct a room polygon.  All room 
outlines are colored blue by BROOM and posted onto the project tree 
regardless of whether they were drawn as rectangular rooms or 
polygonal rooms (Figure 4-20). 
 

Note that corner snapping works for polygonal rooms just as it does for rectangular rooms. 

 
4.7.3. Editing Rooms 

You may wish to edit the dimensions of a room after it has been created.  There are several 
different ways to do this. 
 

 
Figure 4-18.  Add 
Polygonal Rooms 

Button.  

 
Figure 4-20. 

Completed Rooms in Blue.  

 
Figure 4-19.  Adding Room 
Corners in Polygon Mode.  
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Sometimes corner snapping can be a disadvantage.  Occasionally the room corner will snap to 
the wrong corner on the CAD floor plan (Figure 4-22).  Often these corner-snapping problems 
can be minimized by being zoomed-in more closely when drawing rooms.  However, if a room is 
drawn incorrectly, you must either delete it and redraw the room or edit the room that you have 
drawn.  To delete a room, select it in the project tree and click the Delete button on the toolbar 
above the tree (Figure 4-21).  The next section of the manual explains how to edit rooms by 
moving and adding room corners. 

 
4.7.3.1. Moving Room Corners 

If the corner of a room is in the wrong place, it can easily be moved to the correct location.  First, 
pick the Select Object button on the main toolbar (Figure 4-23).  By 
selecting Select Object mode, you are deselecting Add Room mode.  
This allows you to click on the misplaced corner and move it to the 
correct location. 
 
Figure 4-24 shows a room with an incorrectly placed corner.  To fix 
this, simply place the mouse cursor directly over the point.  Click on 

the point and move the mouse cursor to the correct location.  Then release the mouse button, and 
the room corner will move to the new position you indicated with the mouse (Figure 4-25). 

 
Figure 4-21.  Delete 

Button.  

 
Figure 4-22.  Room Snapped to the 

Wrong Corner  

 
Figure 4-23.  Select 

Object Button.  

 
Figure 4-24.  Incorrectly-placed 

Room Corner.  

 
Figure 4-25.  Corrected Room 

Corner.  
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4.7.3.2. Adding Room Corners 

You may find that you missed a corner while drawing a room.  In this case, you will need to add 
a new corner vertex to the room and then drag the new corner vertex to its correct position.  The 
following steps can be used to add a new room corner: 
 

1. Left-click the Select Object button on the main 
toolbar (Figure 4-23). 

 
2. Left-click inside the room on the map to select 

it.  The selected room will be highlighted with 
light-blue boxes on the corners (Figure 4-26). 

 
3. Left-click directly on a room wall (on the blue 

line) somewhere near the midpoint of the line to 
generate a new corner vertex (Figure 4-27). 

 
4. Press and hold the left mouse button on the new 

corner vertex and drag it to its correct position, 
then release your mouse button (Figure 4-28). 

 

 

 
Figure 4-26.  Room with Missing 

Corner.  

 
Figure 4-27.  New Corner Added to Room 

Outline . 

 
Figure 4-28.  New Corner Dragged to 

Correct Location.  
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4.7.3.3. Removing a Room Corner 

In this exercise, we will remove the vertex in 
the middle of the straight wall along the left 
side of Figure 4-29. 
 
Your first task will be to determine the 
coordinates of the vertex you want to remove.  
The current location of the mouse cursor 
within the building is displayed on the status 
bar below the map (Figure 4-30).  Move the 
mouse cursor over the vertex to be removed 
and make note of its coordinates. 
 
If it is not already expanded, expand the 
Collections  property group of the room by 
clicking the plus sign (“+”) to its left in the 
property grid (Figure 4-31).  Then click the 
ellipsis (“…”) button to the right of the 
Polygon property. 
 

The Point Collection Editor should now be visible.  Select the point you want to remove from 
the list of coordinates on the left hand side of the form (Figure 4-32).  Next, click the Remove 
button.  Click OK  to save the change and close the form. 
 

 
Figure 4-29.  Room Vertex to be Deleted.  

 
Figure 4-30.  Mouse Coordinates on Status Bar.  

Delete 
This 

Vertex 
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Once the Point Collection Editor form disappears, the currently selected room will redraw itself 
without the extra vertex (Figure 4-33). 
 

 
Using these three editing operations of adding vertices, dragging vertices to new positions and 
removing extra vertices you can create room outlines of practically any shape you need to model 
rooms in facilities.  Editing rooms is a fast operation.  However, you may not want to take the 
time to make every room’s geometry perfect, particularly in large facilities with complex, curved 
walls.  Sometimes, quickly drawn, simple outlines work just as well.  
 

 
Figure 4-31.  Mouse Click Sequence to Access Point Collection Editor.  

 
Figure 4-32.  Point Collection Editor.  

 
Figure 4-33.  Room with Point 

Removed.  
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4.7.3.4. Troubleshooting Room Edits 

Fixing room corners can be difficult when corners of rooms overlap other rooms.  When you try 
to drag a corner that is in another room, BROOM stops the dragging and makes the second room 

the currently selected room (Figure 4-34).  To get around this problem, just use the Point 
Collection Editor to remove the problem corner, and then generate a new vertex by clicking on 
the room outline and dragging the new corner into its proper position. 
 
4.8. Working with Samples 

Samples exist as database records in BROOM.  BROOM shows samples as circular and 
triangular symbols on the building map.  Sample properties can be viewed and edited via the 
project tree/property grid and the sample datagrid.  In a real-world deployment, samples will 
primarily be created on and uploaded from PDAs.  However, you can manually create samples 
using the desktop application to explore how you interact with them in BROOM. 
 
4.8.1. Creating Samples 

To create a sample, click the Add Surface Samples button on the main 
toolbar (Figure 4-35).  When this mode is active, any left-click you 
make on the map window will create a sample at that position. 
 
As you click on the map, BROOM places samples at those locations 
(Figure 4-36).  These sample locations represent samples that have been 
taken but not been analyzed by a laboratory. 
 

 
Figure 4-34.  Difficulty Editing Overlapping Room Polygons.  

 
Figure 4-35.  Add 
Surface Samples 

Button.  
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Looking over to the left side of the BROOM desktop application interface, notice that a colorful 
legend has been added to the map layer checkbox window (Figure 4-38).  This legend shows the 
colors that will be associated with sample symbols that have various values.  Notice that the new 
samples you have placed on the map have a value of “null”. 

 
Now look over to the right side of your BROOM screen.  Notice that a series of red dots has 
shown up on the project tree (Figure 4-37). One sample node is placed on the project tree for 
every sample that you added to the map.  All of the samples on a floor show up in its Samples 
folder.  The numbers beside the red dots are the database identifiers for the samples.  These 
identifiers will be replaced by the sample barcodes when they are assigned—samples coming 
from the PDA will already have a barcode (which will be displayed in the tree). 
 

 
Figure 4-36.  Samples Placed on Map.  

 
Figure 4-37.  Samples on 

Project Tree.  

 
Figure 4-38.  Sample 

Legend.  
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4.8.2. Editing Sample Properties 

Select a sample on the project tree.  Now look below the tree to the property grid; the property 
grid is now displaying data for the selected sample.  Some of the data fields are already filled in 
with default information.  Grayed-out fields cannot be edited. 
 
Sample properties are edited in the same manner as project, building, floor and room properties.  
Simply place your mouse cursor in the data field space you want to change, click it and then start 
typing in the new information. 
 
To edit the properties for another sample, click on that sample’s node on the project tree (Figure 
4-).  Alternatively, you may select samples directly from the map window by first pressing the 
Select Object toolbar button (Figure 4-23), then clicking the sample symbol on the map with 
your mouse. 
 
The sample datagrid provides a spreadsheet-like view of all the samples in your building, 
allowing large numbers of samples to be quickly examined or edited.  The sample datagrid is 
opened by selecting Building  > Sample Datagrid on the main menu. 
 
The sample datagrid allows you to view the properties for many samples at one time (Figure 
4-39).  To edit a value, click on the proper cell and type in the new value.  Some property fields 
have a fixed number of choices of possible values.  When you click on these fields in the sample 
datagrid, a dropdown list of available choices appears (Figure 4-40).  At this point, you simply 
select the one you want and the property value for that cell is changed. 

 

 
Figure 4-39.  Sample Datagrid.  
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Figure 4-40.  Dropd own List in a Datagrid Cell. 
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4.8.3. Exporting and Importing Sample Data 

The second method for editing sample data uses 
Microsoft Excel to manipulate the data for the 
samples. To use this method, select Data > 
Export XML > Sample Lab Data from the 
main BROOM menu.  This opens up the Export 
Sample Lab Data form which allows you to 
enter (or browse for) the export file name 
(Figure 4-41.  The sample lab data will be 
written to this file. 
 
Type Demodata (or another file name of your 
choosing) in the File name textbox and click 
the Export button.  This will create the file 
containing the BROOM data; this data can now 
be edited in Excel. 
 
The Next step for you to start Excel open a worksheet with the File > Open menu sequence. This 
will bring up an Open form where you can browse for the exported sample data file. Select 
demodata.xml and click the Open button. 
 
Next, the Open XML window pops up asking you how you want the file opened.  Select Use the 
XML Source task pane and click OK (Figure 4-42). 
 
In the XML Source panel at the right side of the Excel spreadsheet, click on the Partitions folder.  
This highlights every node in that folder (Figure 4-43). 

 
Figure 4-41.  Sample Lab Data Export.  

 
Figure 4-42.  Importing XML into Excel.  
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Drag the Partitions folder from the XML Source panel to cell A1 in the spreadsheet (Figure 
4-44).  This defines the column headings for the data that are to be edited (Figure 4-45). 
 

 
Figure 4-43.  XML Source 

Panel.  

 
Figure 4-44.  Drag the Samples to Cell 1A.  

 
Figure 4-45.  Column Headings after 

Completing Drag Operation.  
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To load the sample lab data from the file into the spreadsheet, select Data > XML  > Refresh 
XML  Data from the main menu in Excel.  This will populate the spreadsheet with the sample 
data just like the datagrid in BROOM (Figure 4-46). 

 
You may now edit the data in the spreadsheet cells.  All standard Excel features such as cell 
formulas, copy/paste, etc. are available for you to use. 
 
When you are done editing the data, open the Data > XML  menu and select Export .  This opens 
the Export XML form.  Save the file as an XML file with a different name and then click Export  
(Figure 4-47).  This writes the edited data to an XML file which you will import back into 
BROOM. 
 

 
In BROOM, select Data > Import > XML Sample Lab Data  from the main menu.  This opens 
the Select XML File for Import form.  Find and select the XML file you exported from Excel and 
click Open (Figure 4-48). 

 
Figure 4-46.  Refreshed XML Data Ready to be Edited.  

 
Figure 4-47.  Saving the Edited Data as an XML File.  
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BROOM will now import the data and display a status message when complete. 
 
By selecting different samples in the project tree you can see the data imported from Excel in the 
property grid (Figure 4-49).  The values in the property grid should agree with the values, which 
you entered in Excel.  You can also use the sample datagrid to check the imported values. 

 
Another method exists to import sample data that is easier than the XML file import.  It is a two-
step process.  First, the sample locations are input, then the laboratory results.  To import sample 
locations the user needs to set up a .csv file.  This file can be created in Excel.  There should be 
no header row in the file.  The file should contain columns with the following data: Sample ID 
number, media type (e.g., swab, wipe, etc.), x coordinate, y coordinate, z coordinate.  The file 
should be saved as a .csv file.  Next, the user selects Data > Import > Samples (CSV).  Then a 

 
Figure 4-48.  Selecting the XML file for Import.  

 
Figure 4-49.  Sample Shown in the 

Property Grid.  
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pop-up window appears and the user selects the appropriate .csv file to import.  Proposed 
sampling locations can be imported in much the same manner.   
 
To import laboratory results, the user creates an actual Excel file.  There can be any number of 
fields in the Excel file, but the fields of data that may be imported are: Barcode ID, Partition ID, 
Partition lab ID, Analyst, Analysis method, Date/time analyzed, Quantity measured, Units, 
Agent/analyte, Notes.  Partitions refer to different laboratory analyses (e.g., Sarin, Sulfur 
Mustard).  The Excel file must have a header row to identify the contents of each column of data.  
The most important parameters that need to be imported are the Barcode ID and the Quantity 
measured in order to display results in the BROOM interface.  The Excel file must be a 
consistent format with a .xls file extension, not the new .xlsx extension. To import the sample 
results, select Data > Import Excel Lab Results.  A pop-up much like Figure 4-50 will appear.  
The user selects the file with the Browse button.  The Excel worksheet name refers to that 
worksheet in the Excel file with the laboratory results.  The user can type in a laboratory name, 
or if already in the database, select from the drop-down options. 
 
 

 
 

Figure 4-50.  Selecting the Excel file for Import. 
 
Once the Select a File option is complete, the user selects Next.  Then a pop-up like Figure 4-51 
appears.  The user selects which row contains the header row identifying the contents of each 
column of data.  When complete, select Next.  
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Figure 4-51.  Selecting the Header Row for Import. 
 
The next pop-up window should look much like Figure 4-52.  In this window the user selects 
which columns they want to import relative to the data fields allowed for import (e.g., Barcode 
ID, Quantity measured).  Once the mapping of fields to columns is complete, select Next. 
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Figure 4-52.  Define Column Mapping for Import. 
 
The next pop-up window should look something like Figure 4-53. If the import had not 
prescribed column inputs for Analysis method, units and Agent/Analyte, then this dialog box 
will appear. 
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Figure 4-53.  Selecting Other Parameter Attributes for Import. 
 
When input to this screen has been completed, the user selects Next.  The final screen in the 
process is shown in Figure 4.54 to Finish the import procedure. 
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Figure 4-54.  Final Screen for Import. 
 
Another option for exporting data which is potentially more comprehensive than the XML export 
option is listed as Data > Export > BOTE Samples (CSV).  The file generated from this option is 
fairly comprehensive and can be displayed in Excel quite easily. 
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4.9. Create a Contamination Map 

BROOM creates maps of a facility with the sample symbols colored to indicate the measured 
amount of contaminant.  These sample value maps show which samples have high levels of 
contaminant and which samples have low levels (Figure 4-55, left).  Sample value maps show 
the distribution of samples and help you to understand how the contaminant is distributed. 

 
Contamination maps extend the coloring to the entire surface of the map (Figure 4-55, right).  
BROOM creates contamination maps by generating estimates of contaminant levels at all points 
on the map using known values from the samples.  These maps are useful for viewing the extent 
of the contamination.  You can tell from a quick glance where the clean portions of a building 
are and where the contaminated portions are. 
 
BROOM simplifies the task creating these highly useful 
contamination maps, but it is still an involved process.  
Sample value maps are generated automatically by BROOM 
as values are added to sample locations.  Contamination maps 
require more user interaction, thus they are not automatically 
generated. 
 
Figure 4-56 shows the order of operations you must perform 
to create a contamination map.  You can access all of the 
tools you need to make a contamination map from the 
BROOM toolbar.  First, you will need to generate a Sample 

 
Figure 4-55.  Examples of a Sample Value Map and Contamination Map.  

 
Figure 4-56.  Creating a 

Contamination Map.  
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Set, which is a subset of the samples that you want to be represented in your contamination map.  
Next, you will need to decide what part of the building model you want the map to cover and 
generate a Mesh covering that portion of the building.  The third step is to construct a Variogram 
that describes the spatial relationships amongst the samples in the sample set.  Finally, BROOM 
generates the final map through the process of kriging, making use of the sample set, mesh, and 
variogram. 
 
4.9.1. Getting Started 

To learn how to create a contaminant map, you will first create a new project and building.  The 
procedure for creating a project and building is outlined in Sections 4.3 through 4.7. 
 
4.9.1.1. Create a Basic Building 

You will need to create a simple building in your new project.  Create a building with one floor 
(see Sections 4.6 and 4.6.1).  The floor does not need to have a drawing associated with it. 
 
Next, add one rectangular room to the floor (see Section 4.7.1).  The exact size of the room is not 
important; just create a single room that takes up most of the screen.  Figure 4-57 shows a simple 
building with one floor and one rectangular room. 

 

 
Figure 4-57.  Simple One-Room Floor.  
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4.9.1.2. Configure the Sample Display 

The project’s sample color scale needs to be configured to properly encompass the sample values 
we will be using in this exercise.  First, select View > View Options from the main menu.  This 
will open the View Options form shown in Figure 4-58. 

Select Quantity Measured under Quantitative Results.  Next, select Color Scale (Measured) 
from the list at the left of the form.  The right side of the form will now appear as it does in 
Figure 4-59.  Make the following changes: 

1. Select the Linear  radio button. 
2. Set the Minimum  to 0. 
3. Set the Maximum  to 1000. 
4. Click OK . 

 
Figure 4-58.  View Options Form.  

 
Figure 4-59.  Color Scale Settings.  
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Next, select Data > Options from the main menu.  
This will open the Data Options form shown in 
Figure 4-60.  Make sure Enable quick sample 
entry is checked.  If it is not, click on the checkbox 
to enable it.  When the form looks like it does in 
(Figure 4-61), click OK  to save the settings and 
close the form. 
 
4.9.1.3. Add Samples 

Contaminant maps use the values of existing 
samples to make estimates about contaminant levels 
in unsampled locations.  In this exercise, you will 
add three samples to your simple room so that the 
contaminant mapping procedures have initial data 
to work with. 
 
Make sure the Add Surface Samples button on the 
main toolbar is selected.  Next, click the left mouse 
button at about the center of the room that you previously drew in the building.  This will create 
a sample (an empty circle symbol) at that location and open the Sample Quick-Entry form 
(Figure 4-61).  Select QPCR from the Analysis Method list.  Next, enter 1000 in the Quantity 
Measured field.  The form should look like that pictured in Figure 4-61.  Click OK to complete 

the sample entry procedure. 
 
Add two more samples to your room in the 
approximate locations shown in Figure 4-62. 
Place the second sample about halfway between 
the first sample and the blue room outline along 
the top of the screen.  Assign a value of 500 to 
this second sample.  Place the third sample 
beneath the first sample, but closer to the bottom 
of the room (Figure 4-62).  Give the third sample 
a value of 200. 
 
Save your project by selecting File > Save 
Project from the main menu. 

 
Figure 4-60.  Data Options Form.  

 

 
Figure 4-61.  Adding the First Sample to 

Room.  
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4.9.2.  Scenarios and Workspaces 

Analysis runs and outputs (such as contamination maps) are organized into scenarios and 
workspaces.  A scenario is a broad, arbitrary category of analyses you are performing on a 
project.  A scenario is assigned a name and description of your choosing.  Each scenario is 
subdivided into one or more workspaces.  Workspaces are likewise created and named as you see 
fit.  Simply think of them as folders for organizing your analysis data. 
 
Whenever you generate new analysis results, BROOM needs to 
know which workspace in which to place the results.  When run 
your first analysis, BROOM will present the form shown in 
Figure 4-63 (the form will initially be blank).  Create a scenario 
by clicking the New Scenario button and entering a scenario 
name.  Next, add a workspace by clicking the New Workspace 
button and entering a workspace name.  You may then click OK 
to continue with running the analysis. 
 
If one or more scenarios and workspaces already exist when you 
run an analysis, there are two ways to specify the workspace to 
which the analysis will be assigned.  If a workspace node is 
selected in the project tree (or any run or input/output node 
belonging to a workspace), any analysis you run will 
automatically be assigned to that workspace.  If some other type 
of node (building, floor, sample, etc.) is selected in the project 
tree, BROOM does not know which workspace is the “current” 
workspace.  In this case, when you start an analysis you will see the Select Workspace form 
(Figure 4-63) prompting you to select a workspace.  You may select an existing workspace or 
create a new workspace as described in the previous paragraph. 
 

 
Figure 4-62.  Locations of Samples. 

 
Figure 4-63.  Select 
Workspace Form.  
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4.9.3. Generate a Sample Set 

A sample set is a group of samples defined 
for use in analysis.  Creating a sample set 
is the first step in generating a 
contamination map.  Sample sets can be 
customized with value transforms and 
filters for defining which samples will be 
included in the set. 
 
For this example, you will create a simple 
sample set that contains all three samples 
on the floor. 
 
To create a sample set, click the Create 
Sample Set button on the main toolbar 
(Figure 4-64).  This opens the Sample Set 
Definition form shown in Figure 4-.  The 
form has many options for determining 
which samples are included in the sample 
set.  For this example, leave the form’s 
default values as-is. Click OK  to generate 
the sample set.  You should then see the 
sample set show up in the project tree. 
 
4.9.4. Generate a Mesh 

A mesh is a regular array of points covering the area to be mapped.  When BROOM creates a 
contamination map, it will compute the estimated contamination level for each of the points in 
the mesh.  Meshes can have any number of points in them.  The more points there are in the 
mesh, the better the contamination map will look.  Fewer mesh points will result in a more 
jagged, “blocky” map.  More mesh points will result in a longer computation time when 
generating the map.  Generally, meshes with 1,000 to 10,000 points are a good tradeoff between 
map quality and computation time. 

 
Figure 4-64.  Sample Set Definition Form.  
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To create a mesh, click the Create Mesh 
button from the BROOM toolbar (Figure 
4-57).  This opens the Finite Volume Mesh 
Definition form shown in Figure 4-65.  
Select the following options: 
 

• Mesh Region: Current Room 
• Node Type: Rectangular 
• Mesh Sizing: Node Count 
• Node Count: X Direction = 50 
• Square Cells 

 
Click OK  to generate the mesh. 
 
Mesh generation is a very intensive 

operation and may take a minute or two to complete.  The Accept Mesh form (Figure 4-66) will 
appear when the mesh has been generated.  This form allows you to name the mesh and to view 
it on the map before accepting it.  You can leave the default name or enter a new name for the 
mesh.  Click OK  to save the new mesh.  You should then see the mesh show up in the project 
tree. 

 

 
Figure 4-65.  Mesh Definition Form.  

 
Figure 4-66.  Accept 

Mesh Form. 
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4.9.5. Create a Variogram 

A variogram is the third component required for a contamination map (Figure 4-).  A variogram 
describes how the similarity of samples to one another varies with the distance between them. 
 
To create a variogram, select Analysis > 
Variogram > Easy from the main menu.  If the 
Select a Workspace form (Figure 4-63) appears, 
select a workspace and click OK . 
 
Next, the Easy Variogram Inputs form appears 
(Figure 4-67).  This form requires you to select a 
sample set as the input to the variogram generator.  
In this example, we previously created only one 
sample set; this sample set appears inthe list of 
Available Inputs on the left side of the form.  If you 
had previously created more than one sample set, 
you would see all of them in the list.  Giving the 
sample sets unique names when they are created 
makes them easier to identify.  The properties of 
the selected sample set appear on the right side of 
the form, providing an additional means of 
identifying the desired sample set. 
 
Click on a sample set in the list to select it, and then click OK .  Note that if you gave the sample 
set a different name (the default is “Sample Set”), you would see that name appear in the list. 
 
Next, the Generate Variogram form appears (Figure 4-68).  The form has a graph on the left side 
and some data input boxes on the right.  The vertical axis on the graph displays variability (how 
similar or different pairs of samples are to one another).  The horizontal axis displays the 
distance between pairs of samples.  The red dots on the graph correspond to sample pairs.  There 
are only two dots on the example graph because there are only two pairings of samples (from the 
three samples in the input sample set). 

 
Figure 4-67.  Input Selection Form. 
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The purple curve on the graph is the essence of the variogram.  This curve will be one of the 
inputs used when creating the contamination map.  The curve should fit the general trend of the 
red dots while topping off at the horizontal green dashed line.  The trend of the red dots in our 
small example is not readily apparent; however, the trend is typically obvious in a real-world 
sample set.  BROOM automatically generates its best-guess fit.  Generally, it is sufficient to 
simply click OK  and use the automatically generated variogram. 
 
Verify that your curve (the purple line) looks similar to the one in Figure 4-68.  The parameters 
along the right side may differ, but if the general shape is the same, then the variogram is good.  
The left end of the curve should intercept the bottom of the graph in this example; if not, drag the 
red word “Nugget” down to the bottom of the graph.  This will pull the curve down to the origin.  
Alternatively, you can simply enter 0.0 in the Nugget text box and click Redraw.  You can also 
drag the red word “Range” along the horizontal axis to change the curve.  Try moving Range 
until the curve lines up with a red dot.  Once the purple curve looks somewhat like that in Figure 
4-68, click OK  to accept the variogram.  You should then see the new variogram show up in the 
project tree. 
 
4.9.6. Create a Kriging Map 

The final step in generating a contamination map is to run the Kriging algorithm (step 4 in Figure 
4-56).  Kriging uses a sample set, mesh and variogram to generate contamination estimates at 
each point in the mesh.  These estimates are converted into multicolor maps like those seen in 
Figure 4-55. 

 
Figure 4-68.  Generate Variogram Form.  
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To run Kriging and create a contamination map, select Analysis > Contaminant Map> Easy 
Kriging from the main menu.  If the Select a Workspace form (Figure 4-63) appears, choose 
select a workspace and click OK . 
 
Next, the Input Selection form appears (Figure 4-69).  On this form, you will select a sample set, 
variogram, and mesh as inputs for the Kriging. 

 
Figure 4-69 and the following list describe the steps for selecting the inputs: 
 

1. Select our example sample set in the Available Inputs list. 
2. Click on the Variogram tab. 
3. Select our example variogram in the Available Inputs list. 
4. Click on the Mesh tab. 
5. Select our example mesh set in the Available Inputs list. 
6. Click OK . 

 
Technically, you could skip step 1; when you select the variogram in step 3, the sample set from 
which the variogram was generated is automatically selected on the Sample Set tab. 

 
Figure 4-69.  Selecting Kriging Inputs.  
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After you click OK, the kriging algorithm will begin generating the map.  This can take a few 
minutes, depending on the size of the mesh.  When complete, BROOM displays the Map 
Preview form (Figure 4-70).  This form provides a preview of the map before it is finalized and 
added to the project.  You can specify how the map is colored and how it is rendered.  For this 
exercise, select Current Sample Colors for the Map Color Scale and High Quality for the Map 
Layer Type.  Then click OK to save your choices and display the map. 

The contamination map will appear in the map window and show up in the layers panel as the 
Estimate layer (Figure 4-71). 

 
Figure 4-70.  Map Preview Form.  

 
Figure 4-71.  Completed Contamination Map.  
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4.9.7. Contamination Estimates 

The displayed contamination map (see the previous section) can now be used to determine 
estimated contamination levels anywhere in the room.  First, make sure the map is in Select 
Object mode (Figure 4-).  Now hold your mouse cursor over one of the three samples on the 
map.  A small tooltip window will pop up with information about that sample (Figure 4-72). 

 
Now, slowly move your mouse cursor around within the room while watching the status bar 
directly below the map.  In particular, watch portion of the status bar that is labeled Estimate.  
You will see this value change as you move the mouse around.  The displayed estimate value 
increases when the mouse is over a red area and decreases when the mouse is over a blue area.  
The displayed value is the estimated contamination level that BROOM has calculated for the 
portion of the room under the mouse cursor (Figure 4-72). 
 
4.10. Generate Maps for the PDA 

PDAs have much less memory and processing power than desktop and laptop systems.  
Therefore, it is necessary to create smaller, more efficient building maps for the PDA 
application. 
 
There are two types of maps that can be generated for the PDA: “Image maps” and “CAD 
maps.”  Image maps are bitmap graphics images of what is being displayed in the desktop 
application’s map area at the time the PDA map is generated.  The advantage to using an image 
map is that you can incorporate various map layers into the image (the CAD layer combined with 
the contaminant map layer, for example).  CAD maps have the advantage of high detail and fine 
resolution but can be generated only if there is a CAD map loaded in the desktop application. 
 

 
Figure 4-72.  Obtaining Contamination Estimates.  
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Typically, you will want to generate both image maps and CAD maps for the PDA.  To do so, 
first check or uncheck various map layers to achieve the desired appearance for the image map.  
Then select PDA > Create All PDA Maps for Current Building  from the main menu.  It may 
take a few minutes for the maps to be created, especially if the CAD layer contains a complex 
map.  The maps you just created for the PDA will reside as files on the local computer. 
 
Some points to keep in mind when dealing with PDA maps: 
 

• If you have multiple buildings in your project, you must repeat the above steps for each 
building. 

• If you change a building (add floors, change floor maps, etc.) you must regenerate the 
PDA maps. 

• If you regenerate the PDA maps, remember the PDAs will still have the old maps until 
you re-download them into the PDAs. 

 
5. USING THE PDA 

5.1. PDA Basics 

The BROOM system has two main components:  the desktop application, which runs on a 
standard Microsoft Windows computer, and the PDA application, which runs on a Pocket PC  or 
Windows Mobile PDA (earlier versions of Windows Mobile were called Pocket PC).  The PDA 
acronym stands for “Personal Digital Assistant” and refers to small hand-held computers. Pocket 
PC and Windows Mobile are special variants of the Windows operating system designed for 
PDAs.  “PDA” is the most generic term for these devices, whereas “Pocket PC” and “Palm Pilot” 
refer to PDAs built for competing operating systems, much like “Windows” (or “PC”) and 
“Mac” refer to different platforms. 

 

 
Figure 5-1.   iPAQ Pocket PC. 

 
Figure 5-2.  

Trimble Nomad. 
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5.1.1. Text Entry 

The standard method of interacting with a PDA is via its touch screen.  Text entry may be 
performed using the standard “input panel” control.  This control is activated by tapping on the 
small keyboard, stylus, or handwriting icon in the bottom-right corner of the screen (see Figure 
5-3).  This will pull up a keyboard, handwriting recognizer, or put the PDA in “transcriber” 
mode.  Tapping the icon again will close the control back down.  These modes are selected by 
tapping the up arrow next to the icon, as shown in Figure 5-4.  Note this icon may not always be 
present—it is up to the running application to make it available and is typically not shown on 
screens that do not require text input. 

Keyboard mode provides an on-screen keyboard and is the simplest mode to use.  This mode is 
shown in Figure 5-5.  Text is entered on the screen simply by tapping the keyboard with the 
stylus.  This is the simplest but slowest method for entering text. 

The block recognizer and letter recognizer are represented by the stylus icon.  The block 
recognizer interprets characters drawn on the input panel (see Figure 5-6).  This mode recognizes 
characters drawn in a style developed for older Palm Pilot PDAs.  A better alternative is the letter 
recognizer (see Figure 5-7).  Letter recognizer mode recognizes characters drawn in a more 

 
Figure 5-3.  Text Input Mode Icons. 

 
Figure 5-4.  Text Input Menu. 

 
Figure 5-5.  Keyboard Input Mode.  
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natural manner.  Letters should always be drawn in lower case, however where they are drawn 
on the control (the “ABC,” “abc,” or “123” section) determines how they will be interpreted.  
These modes are slightly more difficult to learn than the keyboard, but once the user is proficient 

they are faster than using the keyboard. 
The transcriber mode (see Figure 5-8) recognizes characters written anywhere on the screen and 
offers many options for fine-tuning its behavior.  It allows the user to write an entire word at a 

 
Figure 5-6.  Block Recognizer Input Mod e. 

 
Figure 5-7.  Letter Recognizer Input Mode.  
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time before it interprets the text.  This is the fastest and most powerful method for text entry, but 
it can also be initially frustrating and has a bit of a learning curve. 

Some PDAs, such as the Trimble Nomad series, provide hardware buttons that can be used for 

entering numbers (see Figure 5-9). 
 

 
Figure 5-8.  Transcriber Input Mode.  

 
Figure 5-9.  Trimble Nomad Keypad. 



69 
 

5.2. Wireless Network 

The PDA and the desktop application communicate via a 
standard 802.11b or 802.11g wireless network using standard 
off-the-shelf equipment (PDAs do not typically support 802.11a 
or 802.11n).  It is assumed that the individual responsible for 
establishing the network has some degree of familiarity and 
experience with such matters. 
 
In this section, the term “server” refers to the desktop/laptop 
computer running BROOM with which the PDA communicates.  
It does not refer to the database server (which may or may not be 
the same computer). 
 
5.2.1. Wireless Router Configuration 

Recommended network configuration: 
 

• Static IP addresses: 
A static address is recommended for the desktop computer acting as the server for the 
PDAs.  The user must initially enter the server’s IP address when configuring BROOM 
on a PDA, thus it is simpler when the server has a static IP address.  Static addresses are 
also recommended for the PDAs themselves to alleviate any confusion when 
troubleshooting network connections. 
All devices should be on the same subnet for all BROOM features to function properly.  
That is, all devices should be assigned addresses in the form of aaa.bbb.ccc.ddd where the 
first three octets (aaa.bbb.ccc) are the same for all devices and the fourth octet (ddd) is 
unique to the device. 
 

• Encryption: 
Network encryption is strongly recommended.  Encryption helps prevent unauthorized 
users from intercepting data and from becoming a member of the network.  Use the 
strongest encryption supported by the PDA.  At a minimum, most (if not all) PDAs 
support 64-bit WEP encryption.  However, WEP can be cracked and defeated easily and 
is effectively useless in protecting your network.  WPA2 encryption is far superior to 
WEP.  The Trimble Nomad PDAs support WPA2 with a pre-shared key (also known as 
“WPA2 PSK” or “WPA2 Personal”) and both the TKIP and AES algorithms.  A WPA2 
key (password) must be between 8 and 63 alphanumeric characters; the more characters 
the stronger the protection.  Furthermore, common sense dictates the use of obscure 
and/or random keys – don’t use “password” for your key.  Use a mixture of upper and 
lower case characters, numbers, and symbols. 

 
5.2.2. PDA Network Configuration 

The PDAs must be configured to connect to the SSID (network name) defined by the router and 
to work with its encryption settings (e.g., WEP or WPA2 and the network key/password).  Static 
IP addresses are recommended (but not required) for the PDAs. 
 

 
Figure 5-10.  Commercial 

Wireless Router.  
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5.2.2.1. Trimble Nomad Configuration 

Network configuration involves two main steps.  First, the PDA’s IP address must be configured.  
Then we will configure the wireless network settings. 
 

1. If using a dynamic IP address (DHCP), this step may be skipped.  Otherwise, to assign a 
static IP address, tap Start > Settings > the Connections tab > Network Cards > the 
Network Adapters tab (“Start” refers to the Windows logo in the upper left corner).  
Tap Marvell SDIO8686 Wireless Card. 
 
Select Use specific IP address (Figure 5-12).  Enter a unique IP address on the same 
subnet as the router.  Set the subnet mask to 255.255.255.0 and set the default gateway 
to the IP address of the router.  Tap OK (upper-right corner) to save the changes. 

2. To edit the wireless network settings, tap Start > Settings > the Connections tab > 
Network Cards.  Tap Add New to bring up the Configure Wireless Network screen.  
Enter the network name (the SSID) and then tap Next.  Select the authentication and 
encryption methods per the wireless router’s chosen configuration.  Typically the 
authentication will be WPA2-PSK and the encryption will be TKIP , but again this 
depends on the settings that the network is using.  Also enter the network key (password) 
and then tap Next.  Then just tap Finish on the final screen. 

 
5.2.3. Desktop/Laptop Network Configuration 

The server computer must be configured to connect to the SSID (network name) defined by the 
router and to work with its encryption settings (e.g., WEP or WPA2).  A static IP address is 
recommended (but not required) for the server.  Assigning a static IP address to the server makes 

 
Figure 5-11.  Network Devices.  

 
Figure 5-12.  Static IP Address.  
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it simpler to know which address to enter when telling the PDAs which computer to connect to 
when transferring data to/from the server. 
 
To configure a wireless network connection in Windows XP, click the Start > Run. Type 
“ncpa.cpl” and click OK  (Figure 5-13). 

The Network Connections window should appear.  Double-click Wireless Network Connection 
(or similar).  You should now see the Wireless Network Connection window (Figure 5-14). 

In the Wireless Network Connection window, click Change advanced settings. 

 
 

 
Figure 5-13.  Accessing the Network Connections Control Panel. 

 
Figure 5-14.  Wireless Network Connection Window.  
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The Wireless Network Connection Properties window (Figure 5-16) should now be displayed. 

 
Click on the Wireless Networks tab (Figure 5-15) and click Add.  The Wireless network 
properties window will appear (Figure 5-17).  Enter the Network name (SSID) as determined 
by the wireless router’s settings.  Set Network Authentication to WPA2-PSK and set the Data 
encryption to TKIP (or other settings based on the actual network configuration).  Enter the 
Network key defined in the router’s settings.  Flip to the Authentication tab and make sure 
Enable IEEE 802.1x authentication is NOT checked.  Click OK  to save your changes and close 
the window.  Click OK  again to close the previous window. 

 
Figure 5-15.  Wireless Networks.  

 
Figure 5-16.  Network Connections.  
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5.2.4. Network Coverage 

Complete wireless coverage (i.e., no dead spots) is not necessary for normal operation.  There 
are two types of data transfers that take place between the PDA and desktop server:  
building/sample transfers and current position updates. 
 
Building/sample transfers are the explicit upload and download operations initiated by the PDA 
operator and can only be performed when the wireless connection is present.  These operations 
cannot be performed when the PDA is in a dead spot with no network coverage.  The PDA 
operator may also wish to move to an area of better coverage before performing an upload or 
download in the outer fringes of the network. 
 
The PDA broadcasts current position updates whenever the user updates their position on the 
map (via manual mode or the laser rangefinder).  These updates will reach the server only if the 
PDA is in an area with network coverage.  However, there is no harm done if there is no 
coverage—the server simply will not receive the updates and the PDA’s current position won’t 
be shown on the server’s map. 
 
5.2.5. Firewalls 

Software firewalls (such as Symantec™ or McAfee®) will interfere with PDA-server network 
communications.  At a minimum, the following ports should be opened for the BROOM 
application running on the server: 
 

• TCP: 50880, 50881 
• UDP: 50882, 50883, 50884 

 

 
Figure 5-17.  Network Properties.  
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You may need to make additional changes to your firewall if you have additional desktop/laptop 
computers connecting to the database over the wireless network.  The firewall on the computer 
running SQL Server must be configured to allow all network communications for SQL Server.  
Some firewalls also may have “intrusion prevention” settings that need to be altered.  Symantec, 
for example, must be configured to stop watching for “MSSQL Null Packet DOS” attacks.  In 
general, it is advisable to consult  your tech support for assistance with your specific 
configuration. 
 
5.2.6. USB Cable / PDA Cradle 

In lieu of a wireless network, a USB cable or PDA cradle may be used for data transfers.  
Building/sample uploading and downloading is possible through the USB cable connected to the 
server.  However, position updates will not function through the cable.  To use the cable with a 
Windows XP machine, make sure Microsoft ActiveSync 4.5 is installed on the server.  To use 
the cable with a Vista or Windows 7 machine, make sure the Windows Mobile Device Center 
(WMDC) is installed on the server.  When the PDA is connected to the cable, ActiveSync or 
WMDC may pop up on the server and ask whether to establish a standard or guest partnership.  
Either is acceptable, but guest is much simpler.  This connection must be established (i.e., the 
above question must be answered) before the PDA and server can communicate. 
 
Note when connecting the Trimble Nomad, the USB cable must be plugged into the “mini-B” 
port (the small trapezoidal port) rather than the “standard-A” port (the larger rectangular port) on 
the PDA. 
 
If the PDA and laptop server do not want to transfer data (e.g., maps), check that a setting on the 
PDA is set appropriately.  From the Start menu in the upper left of the PDA screen, select 
Settings.  Next, select the Connections tab at the bottom of the Settings screen.  Next, tap on the 
USB to PC icon on the screen.  The check box labeled “Enable advanced network functionality” 
should not be checked when communicating with a USB cable. 
 
The BROOM application running on the PDA must be configured to connect to a server IP 
address of 192.168.55.100 (regardless of the server’s actual IP address).  This special IP address 
allows the cable and ActiveSync to mimic a real network connection.  The PDA itself will 
receive the address 192.168.55.101, but will appear to the server as 127.0.0.1, regardless of the 
PDA’s wireless IP address. 
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When the PDA is in the cradle it will typically have 
two IP addresses:  its wireless address and the special 
cradle address mentioned above.  When BROOM is 
started on the PDA, it will recognize this situation and 
ask which IP address to use (Figure 5-18).  It does not 
matter which address is selected in this situation. 
 
5.3. Traveling with the PDA 

Most PDAs will turn on not only when the power 
button is pressed, but will also often turn on when any 
button is pressed.  This increases the chances that the 
PDA will turn on while inside a suitcase during travel.  
If the PDA is on long enough it will drain the batteries.  
To prevent this from happening, the PDA should be 
configured to automatically turn off after some period 
of time.  During normal usage—especially when using 
BROOM—this feature will generally be disabled. 
 
To enable or disable the auto-shutoff feature, tap Start 

> Settings > the System tab > Power > the Advanced tab.  Check or uncheck the turn off 
device if not used for option for battery power (Figure 5-19).  Check this box to enable the 
feature for travel and then uncheck the box when you are ready to use the PDA at your 
destination.  Tap ok to save the changes. 

 

 
Figure 5-18.  Multiple IP Addresses.  

 
 

 
Figure 5-19.  Power Settings. 
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6. USING THE PDA APPLICATION 

In this section, the term “server” refers to the desktop/laptop computer running BROOM with 
which the PDA communicates.  It does not refer to the database server (which may or may not be 
the same computer). 
 
6.1. Starting BROOM 

Initially the BROOM program icon does not appear on the Start menu.  BROOM can be started 
by tapping Start > Programs > BROOM  (Figure 6-1).  It will take about 10 seconds for 
BROOM to start. 
 
You may want to add the BROOM program icon to the Start menu.  You can do this by tapping 
Start > Settings > Menus.  Scroll down the list until you see BROOM and check the box next to 
it.  Tap ok in the upper-right corner, and now the BROOM icon should appear on the Start menu 
(Figure 6-2). 

 
When BROOM is done initializing and is ready to use, you will see the main menu (Figure 6-2). 

 
Figure 6-1.  Programs. 

 
Figure 6-2.  Start Menu. 
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The following functions are available on the main menu: 
 

• Take Samples allows the user to enter data for new samples.  The user is guided through 
a sequence of forms for entering data such as the sample location and barcode. 

• Set Collector allows the user to specify who is collecting the samples. 
• Select Floor/Select Zone allows the user to select the current floor or zone.  This dictates 

which map is shown by the Take Samples function. 
• Download allows the user to download building information (maps, proposed samples, 

etc.) from the server. 
• Upload allows the user to upload new samples to the server. 
• Setup allows the user to edit various configuration settings. 
• Exit  terminates the application. 

 
6.2. Downloading Building Information 

The first step in using the PDA application is to download the building maps and proposed 
samples.  This data transfer takes place over the wireless network (or USB cable—see Section 
5.2.6); it is therefore necessary for both the PDA and server to be connected to the network.  
Note that it is necessary for the PDA to be connected prior to starting the application (likewise, 
the server should be connected before its application is started). 
 
The PDA will communicate with BROOM running on the server; the server’s application must 
be running and have the desired project loaded.  The PDA will have access to data for any of the 
buildings in the server’s project. 
 

 
Figure 6-3.  Main Menu.  

 
 



78 
 

Before the PDA can download maps, the server must first generate special maps for the PDA.  
These maps are in a smaller, more efficient format than those used by the desktop application 
(and in some cases, they are broken up by zone).  Refer to Section 4.10 for instructions on how 
to create the maps for the PDA. 
 
To connect to the server and begin the download process, tap Download on the main menu.  
This will open the Building Download form (Figure 6-5).  There are two components to this 
form:  the upper half allows the user to scan the network for BROOM servers; the lower half 
(shaded light blue) specifies the network address of the desired server.  If no server IP address 
has previously been specified, the window shown in Figure 6-4 will appear.  Tapping Yes will 
search the network and populate the Servers found on network list.  This can also be performed 
by tapping Scan for Servers.  Tap an address in the list and then tap Select to copy this address 
into the blue Server IP address fields.  Alternatively, an address may be manually entered by 
tapping in the first of the four address text boxes (to place the cursor) and then using the text 
entry control (the keyboard or stylus icon at the bottom of the screen (see Section 5.1.1)).  Note 
that if no servers are found during a network scan it does not necessarily mean they are not there.  
It may be necessary to repeat the scan a time or two.  Also, verify that both the server and PDA 
are connected to the network and have a reasonably strong wireless signal.  The scan feature is 
merely provided as a convenience—if necessary simply enter the server IP address manually. 

 
Tap the Download button to request the initial building information from the server.  A few 
moments will pass while the data is being transferred over the network, and then the Available 
Downloads form (Figure 6-6) should appear.  Tap the Building  dropdown list to select a building 
(if more than one is defined in the server’s project).  There are two options governing the maps 
that will be downloaded.  The default is to download maps for the entire floors.  Optionally, if 
zones are defined in the building, the user may select specific zones and download only the 

 
Figure 6-4.  Server Search.  

 
Figure 6-5.  Server Address.  
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subsets of the map for the areas defined by the selected zones.  Large and complex maps can 
slow down the PDA’s performance; it may be advantageous to download only the zones of 
interest.  To do this, select Selected zones and then tap the checkboxes for the desired zones 
(Figure 6-7). 

 
Tap Download to request the maps from the server.  The maps (and other data such as proposed 
samples) will now be transferred across the network.  This may take as long as several minutes 
depending on the complexity of the maps and the 
wireless signal strength.  A message will appear when 
the download is complete (Figure 6-8).  Tap OK  to 
acknowledge the message.  The PDA will now store the 
data in its local memory—this may take another minute 
or two.  The main menu will appear when the process is 
complete. 

 
Figure 6-6.  Available Downloads.  

 
Figure 6-7.  Selected Zones.  

 
Figure 6-8.  Successful Download. 
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6.3. Specifying the Collector 

The collector is the person performing the sample collection.  The application tracks the name of 
the collector and stores it as a part of the sample data.  To change or enter a new collector, tap 
Set Collector on the main menu.  Initially there are no defined collectors. 

 
To add a new collector, tap inside the Add Collector to List text box (Figure 6-10) and use the 
text input control (see Section 5.1.1).  Once you have entered the new name, tap Add and the 
collector will appear as the Current collector.  If multiple collectors have been added, tap the 

 
 

 
Figure 6-9.  Collectors Form.  

 
Figure 6-10.  New Collector.  

 
Figure 6-11.  Existing Collectors.  
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Current  dropdown list and choose from the existing collectors (see Figure 6-11).  Tap OK  to 
save the selection and close the form. 
 
6.4. Selecting a Floor or Zone 

The PDA application has a concept of the “current floor” (or zone).  The current floor (or zone) 
determines what map is displayed when collecting samples.  Furthermore, new samples are 
assigned to the current floor when they are created. 
 
The type of maps (whole-floor or zone-specific) downloaded from the server (see Section 6.2) 
determines whether the user will be selecting a “current floor” or a “current zone.”  If whole-
floor maps were downloaded, the Select Floor button on the main menu will allow the user to 
select the current floor.  If zone maps were downloaded, the same button will be labeled Select 
Zone.  Selecting a zone is a two-stage process—first a floor is selected and then a zone is 
selected from that floor. 
 
To select a floor (when whole-floor maps have been downloaded), tap Select Floor on the main 
menu.  Tap on the Current Floor  dropdown list to select one of the floors in the current building 
(see Figure 6-12).  Tap OK  to save the selection and return to the main menu. 

 
To select a zone (when zone maps have been downloaded), tap Select Zone on the main menu.  
Tap on the Current Floor  dropdown list to select one of the floors in the current building (see 
Figure 6-14).  Of the downloaded zones, those that have boundaries on the selected floor appear 
in the “Current Zone” list.  Tap on a zone name to select it.  Tap OK  to save the selection and 
return to the main menu.  Note it is possible that there may be no zones listed for a particular 
floor; the downloaded zones might exist only on certain floors. 

 

 
Figure 6-12.  Floor Selection. 

 
Figure 6-13.  Floor Selection. 
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6.5. Collecting Samples 

Tap Take Samples to begin the process of collecting a sample.  This will initiate a sequence of 
forms for entering the data associated with a sample.  There are six screens in this sequence: 

• Map 
• Position (details) 
• Collection Method 
• Sample Surface 
• Sample Bar Code 
• Sample Notes & Photo 

 
6.5.1. Map / Sample Position 

The first sample collection form is for the sample position (the location within the building).  
This is actually a combination of two forms:  one shows the text of the x, y, and z coordinates 
and the other displays a map.  Initially the first form appears as it does in Figure 6-15.  This text 
form is primarily used for entering a z coordinate (the elevation of a sample off the floor, such as 
the height of a tabletop).  Otherwise, the map form is used for determining the sample position.  
Tap Show Map to display the map.  Before doing this, however, it is recommended to check the 
Automatically display map option (see Figure 6-16); this will cause the map to automatically 
appear rather than requiring you to tap the Show Map button for each new sample from this 
point on.  With this option checked, the next time you tap Take Samples on the main menu the 
map will appear rather than the text form. 

 
Figure 6-14.  Zone Selection. 
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The map form is shown in Figure 6-17.  The displayed map will of course depend on the map 
downloaded from the server.  Initially the map will be zoomed out; generally the user will have 
the map zoomed in to some degree (see Section 6.5.1.2.3).  The orange crosshairs (near the 
bottom left of the map) represent the origin of the map’s coordinate system (0,0).  The red 
crosshairs (near the center of the figure) indicate the position of the sample being taken.  The red 
crosshairs will move about the map as a result of various kinds of user input.  The map can be 
panned, zoomed in and out, and various types of data can be displayed or hidden.  The toolbar 
buttons (along the bottom of the form) control these functions and are explained in the following 
sections. 

 
Figure 6-15.  Sample Position Form. 

 
Figure 6-16.  Sample Position Form. 
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6.5.1.1. Manual positioning mode 

The Manual button at the top left places the map in manual positioning mode.  This mode allows 
the user to tap on the map to indicate the sample’s position, as shown in Figure 6-18 (the map 
shown has been zoomed in somewhat—zooming is explained in Section 6.5.1.4 “Navigating the 
Map”).  Note the thin black box outlining the button as well as Manual Position Mode appearing 
just above the toolbar.  The arrows extending from the red crosshairs display the distances to the 
walls (in meters). 
 
You may repeatedly tap on the map to adjust the sample position.  Tap OK  in the lower right 
corner to accept the position and return to the Sample Position text form. 
 
6.5.1.2. Laser positioning mode 

The Laser button at the top center places the map in laser positioning mode.  This mode allows 
the user to use a Leica Disto Plus, Leica Disto D8, or TruPulse 360B laser rangefinder to 
determine the sample’s position within a room.  There is some setup required prior to selecting 
this mode.  Section 6.5.1.2.1 describes the initial setup procedure.  Section 6.5.1.2.2 describes 
how to use the laser rangefinder. 

 
Figure 6-17.  Map Form in Manual 

Position Mode. 

 
Figure 6-18.  Manual Position 

Mode, Zoomed In. 
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6.5.1.2.1. One-time Laser Rangefinder Setup 

The PDA communicates with the laser rangefinder via a Bluetooth wireless connection.  Before 
using the rangefinder, some one-time setup must be performed to make the PDA aware of the 
rangefinder as a Bluetooth device.  Note these steps and screenshots are geared for the Trimble 
Nomad PDA and may vary depending on your specific PDA.  To perform this setup, tap the 
Start button (the Windows logo in the upper-left corner) > Settings > the Connections tab > 
Bluetooth.  Then go to the Mode tab and turn on Bluetooth (Figure 6-19).  Next, go to the 
Devices tab (Figure 6-20).  Now, before attempting to connect to the rangefinder, we must turn 
on the rangefinder and enable its Bluetooth capability. 

 
Figure 6-19.  Turning Bluetooth On. 

 
Figure 6-20.  Bluetooth Devices.  
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If using the Leica Disto Plus or the Disto D8 rangefinder, turn it on and press its Bluetooth 
button (Figure 6-21).  A flashing Bluetooth icon should appear on the display.  At this point you 
have 2 minutes to complete the remaining configuration and connect to the PDA or the 
rangefinder will turn its Bluetooth back off.  If it does automatically turn off, simply press the 
button again to turn it back on. 
 
If using the TruPulse 360B rangefinder, first turn it on by pressing the FIRE  button.  Next, look 
through the viewfinder and press and hold the down arrow key until “Units” appears.  Release 
the key and then apply one short press of the same down arrow key so that “bt” appears.  Press 
the FIRE button to select bt.  Now either “btoff” (Bluetooth is off) or “bt_on” (Bluetooth is on) 
will appear.  If “btoff” is shown, press the down arrow key to change to “bt_on.”  In either case, 
press the FIRE  button to accept the displayed setting.  Tap Next on the PDA to begin searching 
for Bluetooth devices. 

 
Figure 6-21.  Leica Disto Plus Buttons. 

 
Figure 6-22.  TruPulse 360B Buttons. 

 
Figure 6-23.  Bluetooth Passcode.  

 
Figure 6-24.  Bluetooth Serial Port.  
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Now return to the PDA and tap Add new device (Figure 6-20).  The PDA will spend about 15 
seconds searching, and then the rangefinder should appear in the list of devices (Figure 6-23).  It 
will be called “DISTO nnnnnnnn” or “TP360B-nnnnnn” where n is the rangefinder’s serial 
number.  Select this device by tapping on it in the list and then tap Next. 
You will now be asked to enter a passcode to connect to the rangefinder (Figure 6-23).  Enter 
0000 for the Leica Disto Plus and Disto D8 or 1111 for the TruPulse 360B.  Tap Next after 
entering the passcode. 

 
On the Partnership Settings screen (Figure 6-24), 
check the box next to Serial Port and then tap Finish.  
At this point you will return to the main Bluetooth 
settings screen (Figure 6-20).  Go to the COM Ports 
tab and tap New Outgoing Port (Figure 6-25). 
Next, you will see the Add a Device screen.  Select the 
name of the rangefinder device and tap Next.  Now, on 
the screen seen in Figure 6-26, make sure COM8 is 
selected and make sure Secure Connection is NOT 
checked.  Now tap Finish and then tap ok in the upper 
right to exit the Bluetooth configuration. 
 
The PDA is now configured to use the specific 
rangefinder used in these steps.  Imagine several 
PDAs—each with their own rangefinder—being used 
simultaneously.  Because each PDA is wirelessly 
communicating with its rangefinder, each PDA must 
know specifically which rangefinder to talk to.  It is for 
this reason that the PDA is configured to work with a 
single, specific rangefinder.  To use a different 

rangefinder, repeat these steps to establish a new link between the PDA and rangefinder. 

 
Figure 6-25.  Outgoing Port.  
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6.5.1.2.2. Using Laser Positioning Mode 

Laser positioning mode allows the user to easily determine the sample’s position by firing the 
laser at two walls of a room.  Given the current 
room and the two distance measurements, the 
application can determine the position within the 
building. SNL was granted a patent for this 
functionality.   
 
The Laser button (top center) places the map in 
laser positioning mode.  The PDA will attempt to 
connect to the rangefinder the first time the laser 
toolbar button is tapped.  Prior to selecting laser 
positioning mode, the rangefinder must be turned 
on with Bluetooth enabled.  On the Disto, the 
Bluetooth indicator will flash while Bluetooth is 
enabled but not yet connected (Figure 6-26).  It is 
important to note that the rangefinder will turn off 
Bluetooth if no connection is established within two minutes.  If this happens, simply turn 
Bluetooth back on by pressing the button on the rangefinder.  The TruPulse lasers are simpler—
as long as the initial configuration (Section 6.5.1.2.1) was successful, the TruPulse merely needs 
to be powered on. 
 

To connect the PDA to the rangefinder, select laser 
positioning mode by tapping the Laser button.  After a 
few seconds, the screen will indicate a successful 
connection.  This connection will remain in effect until 
BROOM is exited.  The Leica rangefinders are under 
the control of BROOM and cannot be turned off until 
the connection is broken. The TruPulse rangefinder is 
not explicitly controlled by the PDA, like the Leica, but 
does transmit distance data to the PDA. 
 
The map should now be in laser positioning mode (see 
Figure 6-27).  Note Fire laser to adjust sample position 
appearing just above the toolbar. 
The next step is to manually place the red crosshairs in 
the room in which you are standing by tapping in the 
room (see Figure 6-28).  It is a good practice to place 
the crosshairs at a rough approximation of the sample 
position.  It is necessary to place the crosshairs in the 
correct room in order to translate the rangefinder’s 
measurement to the correct position on the map. 

 
Figure 6-26.  Rangefinder Buttons.  

 
Figure 6-27.  Laser Positioning 

Mode. 
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The following narrative discusses the use of the Leica laser system.  Now return to laser 
positioning mode (tap the laser mode button).  To take the first distance measurement, aim the 
laser at a wall and tap that same wall on the map.  To ensure the application correctly interprets 

your wall selection on complex maps, it is a good 
practice to follow the arrow coming from the crosshairs 
and tapping where it meets the wall as shown in Figure 
6-29.  In this example, the laser was fired at the wall to 
the north of the crosshairs.  Note the new position of 
the crosshairs, now 7.555 meters from the north wall. 
 
Next, establish the position along the other axis by 
selecting a perpendicular wall and taking the second 
measurement.  In Figure 6-30, the laser was fired at the 
west wall.  Note the distance from that wall has 
changed to 6.315 meters. 
 
You may take as many measurements as necessary to 
establish the sample position.  When the rangefinder 
takes a measurement, you will see the red laser dot 
momentarily appear on your target surface.  Watch for 
this to ensure you hit your intended target; sometimes 
the laser is not aimed exactly where you intended and 
you will have to retake a measurement.  You may 
accidentally hit a column rather than the wall behind it, 

 
Figure 6-28.  Laser Room Selection.  

 
Figure 6-29.  First Laser 

Measurement.  

 
Figure 6-30.  Second Laser 

Measurement.  
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for example.  Also, be aware of windows and reflective surfaces (especially mirrors).  The laser 
will likely just go through a window.  Hitting a mirror will extend the measured distance to 
whatever object the laser hits after bouncing off the mirror. 
 
When you are satisfied with the measured position, tap ok in the upper right corner to accept the 
position and return to the sample position text form. 
 

6.5.1.2.3. Leica Laser Control Modes 

There are three different modes for controlling the rangefinder: 
 

• Single Shot/1-Pick:  this is the default mode.  To take a measurement, tap a wall on the 
map to fire a short laser burst.  This mode is fast and simple but can make it difficult to 
visually verify where the laser actually hit. 

• Point and Shoot/2-Pick:  this mode requires two screen taps to take a measurement.  First, 
tap anywhere on the map to turn the laser on.  The laser remains on, allowing you to aim 
the beam to the intended target.  Once the beam is aimed, taps a wall on the map to take 
the measurement. 

• Continuous Shot/Multi:  this mode provides a periodic live update of the current distance 
from a wall.  Taps a wall on the map to turn on the laser.  The rangefinder will 
continually take periodic measurements and update the position of the red crosshairs on 
the map.  You can then walk towards or away from the wall until at the desired position.  
This mode is useful when trying to line-up with some predetermined position (such as a 
proposed sample).  To turn off the laser and stop the updates, tap the screen. 

 
There are two ways to set the laser control mode.  From the map, set the mode via the Map 
Options (see Section 6.5.1.5).  From the main menu, set the mode via the Setup > Laser menu 
(see Section 6.7.3). 
 

6.5.1.2.4. TruPulse Operation 

The TruPulse laser rangefinder functions more simply than the Leica lasers.  Once the user has 
tapped the Laser button on the PDA map, then they should pan/zoom to the room they are taking 
samples in.  By tapping in the confines of the room the target icon appears and the distances in 
meters to each wall are displayed on the map.  Next the user positions the TruPulse over the 
location that is being sampled and fires the laser at a wall.  It is advisable to look through the 
viewfinder of the TruPulse to determine where the device is being aimed.  The TruPulse contains 
and infrared laser, which is not visible to the naked eye.  Therefore, caution must be exercised in 
firing the laser at the appropriate target on the wall, such that the laser is not aimed at some other 
object like a desk or bookshelf.  The TruPulse laser has a directional compass built in to the 
device and transmits this information to the PDA as well.  The PDA determines which wall has 
been shot with the laser and updates the location on the PDA map.  Therefore the user does not 
have to indicate on the PDA which wall is being shot.  Next, the user turns the laser 90o to an 
adjacent wall and fires the laser again.  This in turn updates the location of the sample.  When 
satisfied with the positioning of the sample, the user taps the OK  icon.  The next screen is a 
summary of the coordinate information and has an icon to return to the map (see Figures 6-15 
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and 6-16).  The user may now enter a z height for the sample if desired.  By tapping on Edit  a 
pop-up will appear with a number keypad to enter values.  Alternatively, when using the 
TruPulse, the device can be tilted downward and the user pushes the fire button to take a height 
measurement.  The TruPulse has a tilt meter that allows it to sense when in a vertical position for 
this height measurement. 
 
6.5.1.3. Proposed Samples 

Proposed samples are locations where a sample should be taken.  These come from the desktop 
application at the same time that the maps are downloaded into the PDA.  Proposed samples 
appear on the map as blue dots.  To enable or disable the display of proposed samples, tap the “i” 
toolbar button to open the Show on Map screen (Figure 6-32).  Then check or uncheck the 

Proposed Samples box and tap OK . 
6.5.1.4. Navigating the Map 

The map may be zoomed in and out and panned in the four cardinal directions.  The following 
sections describe these features. 
 

 
Figure 6-31.  Proposed Samples On 

Map. 

 
Figure 6-32.  Proposed Sample 

Option . 
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6.5.1.4.1. Window Zoom 

The zoom window button places the map in a mode that 
allows the user to draw a red box/window around a 
region to zoom in to.  Note the thin blue box outlining 
the button as well as Drag stylus to define zoon window 
appearing just above the toolbar when selected (Figure 
6-33). 
 
To draw the zoom window, place the stylus at the 
upper-left corner of the desired region.  Drag the stylus 
to the lower-right corner of the region and then lift the 
stylus.  The map will zoom in to this region.  Figure 
6-33 shows a zoom window (red square) drawn around 
the southern portion of the building map.  Note this is a 
“single use” button, meaning you will no longer be in 
zoom window mode after performing the zoom.  Tap 
the button again if you wish to zoom again. 
 
 

6.5.1.4.2. Zoom In and Zoom Out 

The zoom in and zoom out buttons zoom in or zoom out one step.  They are not modes, meaning 
the buttons perform one-time actions and do not stay selected. 
 

6.5.1.4.3. Zoom World 

The zoom world button zooms all the way out to show the entire map.  It is not a mode, meaning 
the button performs a one-time action and does not stay selected.  This button is useful if you 
have become disoriented or zoomed-in too far on the map. 
 

6.5.1.4.4. Panning 

The panning mode allows you drag the map with the stylus in order to adjust which portion of 
the map is visible.  Note the thin blue outline surrounding the button when selected, as well as 
the Drag stylus to move map  visible just above the toolbar.  Unlike the other toolbar buttons, this 
one remains selected until you tap it again to deselect it and exit the mode.  Also, note that you 
may pan the map up, down, left, or right at any time regardless of the map mode by tapping just 
outside the map in the desired direction. 
 
6.5.1.5. Map Options 

 
Figure 6-33.  Zoom Window Mode.  
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The map options button allows the user to control what is and is not shown on the map.  Tapping 
the button brings up the form shown in Figure 6-34. 

 
• Image controls the visibility of the map image 

received from the server. 
• CAD controls the visibility of the CAD drawing 

received from the server.  The CAD drawing 
will only be available if the server’s map is 
CAD-based. 

• Rooms controls the visibility of the room 
definitions provided by the server.  Room 
outlines show up as red on the map. 

• Dims controls the visibility of the “distance 
arrows” that extend from the red crosshairs on 
the map.  When Dims are enabled, the distance 
of the sample position from each wall is shown. 

• Datums controls the visibility of datums on the 
map (datums are very rarely used). 

• Grid  controls the visibility of a 1-meter grid 
overlay on the map. 

• Samples controls the visibility of samples that 
have been taken but not yet uploaded.  Samples 
appear as red dots on the map. 

• Info is no longer used and can be ignored. 
• Proposed Samples controls the visibility of proposed samples.  Proposed samples appear 

as blue dots on the map.  Proposed samples can be filtered by groups via the main menu, 
as described in Section 6.7.1. 

• The laser control mode can be set with the dropdown list to the left of the OK button.  See 
Section 6.5.1.2.3 for a description of these modes.  These modes apply only to the Leica 
Disto Plus laser. 

 
6.5.2. Collection Method 

The Collection Method form (Figure 6-35) is reached by tapping Next on the Sample Position 
form (if you are on the map screen, you must hit OK  at the bottom right to return to the Sample 
Position form). 
 
Tap one of the icons to select the collection method.  The selected method is highlighted blue 
with bold text.  Swab is the selected method in Figure 6-35. 
 
Tap Next to accept the collection method and advance to the Sample Surface form. 

 
Figure 6-34.  Map Options.  
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Figure 6-35.  Collection Method Form.  
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6.5.3. Sample Surface 

The Sample Surface form is reached by tapping Next on the Collection Method form.  This form 
allows the user to specify the type of object being sampled (floor, desk, etc.), the orientation of 
the surface (horizontal upward-facing, vertical, etc.), the surface texture (glass, carpet, etc) and 
the size of the area sampled.  Tap the Surface Object, Surface Orientation, or Surface 
Texture box to drop down a list of possible selections.  The Surface Area can be edited by 
tapping in the text box and then using the text input control (see Section 5.1.1). 
 
Tap Next to accept the selections and advance to the Sample Barcode form. 

 
Figure 6-36.  Sample Surface Form.  

 
Figure 6-37.  Surface Object List.  
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6.5.4. Sample Barcode 

The Sample Barcode form (Figure 6-38) is reached by tapping Next on the Sample Surface form.  
This form allows the user to enter the sample’s barcode, either by using a scanner or by manually 
entering the text. 

The Trimble Nomad PDA (certain models) has an integrated barcode scanner.  To scan a 
barcode, hold the barcode about 6 inches from the scanner (at the top of the PDA) and press the 
Windows logo hardware key at the top left of the hardware keypad.  The laser will read the 
barcode and populate the text box on the screen (Figure 6-39) (or the laser will give up after 3 
seconds if no barcode is found – just press the key again to try again). 
 
If the barcode scans successfully but doesn’t appear on the form, make sure the cursor is blinking 
in the Bar Code text box.  Tap inside the text box and then try scanning again. 
 
The Clear button can be used to erase the Bar Code text box. 
 
If necessary, a barcode can be manually entered by using the text input control (see Section 
5.1.1). 
 
Tap Next to accept the barcode and advance to the Sample Notes & Photo form. 

 
Figure 6-38.  Barcode Form.  

 
Figure 6-39.  Scanned Barcode.  
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6.5.5. Sample Notes & Photo 

The Sample Notes & Photo form (Figure 6-40) is reached by tapping Next on the Sample 
Barcode form.  This form can be used to enter any notes concerning the sample.  The notes 
might contain anything unusual about the sample or a justification for taking it, for example.  
The text is entered using the text input control (see Section 5.1.1).  You may also use this form to 
take a photograph of the sample location.  Tap the Take Photo button to switch to camera mode.  

You will see a live preview on the screen.  Press the enter key (↵) on the hardware keypad to 
take the photo.  You will then see the frozen image on the screen.  Press the enter key again to 
return to the Sample Notes & Photo form.  The photo is now part of the sample record. 

Tap Save to store the sample locally on the PDA.  The sample will not be sent to the server until 
an upload is initiated by the user (see Section 6.6).  Once the sample is saved, the sampling 
screen sequence restarts; the Sample Position or map form will appear for a new sample to be 
taken.  To exit to the main menu at any time, tap Cancel.  If the map form is being displayed, it 
must first be closed (tap ok in its upper-right corner) to be able to see the Cancel button on the 
Sample Position form. 

 
Figure 6-40.  Sample Notes Form.  

 
Figure 6-41.  Sample Notes.  
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6.6. Uploading Collected Samples 

To upload new samples to the server, tap Upload on the 
main menu.  The Upload to Server form (Figure 6-42) 
will appear. 
 
This form displays information about the upload 
operation.  The first two lines show the number of data 
items that you have collected that are ready to be 
uploaded.  For the example in Figure 6-42, no datums 
and two samples have been collected and are ready to be 
uploaded to the BROOM server.  Beneath the blue box, 
the server address is listed.  Double check this value; it 
should agree with the server address you used when you 
downloaded the building and sample information at the 
beginning of the sampling sequence. 
 
Before you can upload the sample data, you must sign 
your name in the white rectangular space inside the light 
blue box with the stylus.  Your signature in the box 
attests that you collected that data that you are about to 
upload.  Creating your electronic signature is simple; just write your name inside the box.  You’ll 
find that it may take a few times to get a recognizable signature.  To erase your signature and try 
again, just tap the Clear button.  Once you have a satisfactory signature, tap the Upload button 
to begin the upload process. 
 
The PDA establishes contact with the BROOM server and then attempts to upload the sample 
data.  If the upload is successful, a small alert window pops up telling you that the upload is 
complete (Figure 6-43, center).  After tapping on the OK  button, the upload form is changed to 
reflect the successful upload status (Figure 6-43, right).  Notice that the signature box has been 
removed because your signature has already been transmitted.  Also, the quantity of samples that 
had shown up in the Ready list is now in the Sent list.  The green check mark next to the sent 
sample total confirms that those samples did make it to the server.  Since everything went 
through successfully, tap the Close button to return to the main menu. 

 
 

 
Figure 6-42.  Upload Form. 
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6.6.1. Troubleshooting Uploads 

In the event of an error during the upload process, and 
alert such as the one shown in Figure 6-44 will appear.  
The most likely cause of a failure is the loss of the 
wireless network connection.  In larger buildings, 
wireless coverage can be spotty, so it is often a good 
idea to upload from a location where you know that the 
wireless signal strength is high.  Usually, the best 
location with the best wireless signal strength is very 
close to the wireless router.  If you do get an error alert 
such as that shown in Figure 6-44, first try walking to a 
location close to the router and repeating the upload 
procedure.  Once wireless connectivity is re-established 
the upload should progress normally. 

 
Figure 6-43.  Upload Screen Sequence. 

 
Figure 6-44.  Upload Error.  
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6.7. Miscellaneous Configuration 

There are several configuration options available from the main menu.  They are accessed by 
tapping the Setup menu at the bottom-left of the main menu (Figure 6-45). 

 
6.7.1. Proposed Sample Groups 

To filter the proposed samples that appear on the map, select Proposed Sample Groups from 
the Setup menu on the main menu.  The Proposed Sample Groups form (Figure 6-46) allows the 

 
Figure 6-45.  Setup Menu.  

 
Figure 6-46.  Proposed Sample Groups Form.  

 
Figure 6-47.  Selected Groups.  
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user to select which groups will be visible.  The Existing Groups list contains all of the groups 
defined in the proposed samples received in the last download from the server.  By selecting a 
group in Existing Groups and then tapping Add, the group will be added to the Selected Groups 
list.  Proposed samples belonging to groups in the Selected Groups list will be visible on the 
map.  To remove a group from Selected Groups, select the group name and then tap Remove.  
Figure 6-47 shows that group “Team B” has been added to the Selected Groups list.  The Other 
Group text box allows the user to add a nonexistent group to the Selected Groups list.  The user 
may wish to do this in anticipation of a proposed sample group that will be downloaded at a later 
time. 
 
Note that proposed samples with no assigned group (a blank group name) will always be visible 
on the map. 
 
Tap OK  to save the changes (or tap Cancel to abort) and return to the main menu. 
 
6.7.2. Outgoing Sample Group 

The Outgoing Sample Group can be configured to assign a sample group to new samples as they 
are created on the PDA.  Tap the Setup menu from the main menu, and then tap Proposed 
Sample Groups.  Then tap the Group Out tab (to the right of the Group In tab) to display the 
Outgoing Sample Group form (Figure 6-48). 

Tap in the Group text box to enter the group name using the text input control (see Section 
5.1.1).  Close the text input control (tap on the keyboard, stylus, or handwriting icon in the 
bottom-right corner) and tap OK  to save the changes (or Cancel to abort) and return to the main 
menu. 

 
Figure 6-48.  Outgoing Sample 

Group Form.  

 
Figure 6-49.  Outgoing Sample 

Group.  
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6.7.3. Laser Control Mode 

Tap Setup > Laser from the main menu to configure the laser control mode.  Note this setting 
pertains only to the Leica Disto Plus laser.  The three modes are described in Section 6.5.1.2.3.  
Tap OK  to save the change (or Cancel to abort) and return to the main menu. 

 
Figure 6-50.  Laser Configuration Form.  
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7. ADVANCED ANALYSIS USING BROOM 

7.1. Overview 

BROOM provides a rich variety of integrated analysis tools.  These tools provide the means to: 
(a) better understand the extent and magnitude of the contamination event and (b) generate 
operational recommendations for number and location of samples that need to be taken. 
 
The tools provided can be categorized into four main groups: 

1. Enabling tools:  Generate sample sets and spatial constructs that are used by other tools 
2. Mapping tools:  Generate estimates of contaminant concentration at locations where no 

samples were taken.  These estimates are then plotted on maps. 
3. Conventional Sample Design Tools:  Create sampling plans and proposed sample 

locations based on traditional statistical approaches 
4. Optimized Sampling Design Tools:  Apply machine-learning methods to define the 

best possible sample sites based on prior results. 
 
A major strength of the BROOM analysis tool suite lies in its tight coordination with other 
BROOM components.  The tools are tightly integrated with the sample dataset and the building 
model for input.  Output can be viewed immediately by use of the BROOM visualization system 
of maps and graphs.  Finally, analysis input, output and metadata are stored seamlessly in the 
BROOM database. 
 
7.2. Enabling Tools 

The sophisticated mapping, statistical and optimization functionality exposed by the analysis tool 
suite relies on simple common data collections to describe samples and areas of the building.  
BROOM provides easy to use enabling tools which construct these simple data structures which 
are used by more advanced analysis tools. 
 
7.2.1.  Sample Sets 

A Sample set is a snapshot of the locations and values of samples used in an analysis.  BROOM 
provides interactive user controls to filter the full sample dataset to produce sample sets that 
meet particular criteria.  Sample sets maintain historical validity even if samples locations are 
later recomputed or sample values are analyzed again and found to be different. Once generated, 
the sample locations and values of a sample set become disassociated with the BROOM sample 
dataset.  That is, an edit or deletion of a sample’s location of laboratory value after a sample set 
is created does NOT retroactively alter values in the sample set. 
 
7.2.1.1. Sample Set Filters 

Filters can be defined to create sample sets which are smaller than the current floor’s entire 
sample dataset.  BROOM supports four methods of filtering sample sets.  The sample set filters 
are additive, if more than one method is defined, samples must pass through all active filters to 
remain in the sample set. 
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7.2.1.1.1. Collection Method Filter 

Any combination of sample collections methods may be 
specified in constructing a sample set (Figure 7-1).  The 
accompanying filter shows a collection method filter 
being defined to include samples collected with wipes 
and mini vacuums.  This filter will exclude any samples 
collected with any of the methods shown in Figure 7-1 
which are not checked.  Collection method filters are 
particularly useful when dealing with scenarios for which 
the factors used to normalize quantity measured sample 
values to surface contamination are not well constrained.  
Surface contamination normalization may not produce 
consistent values in instances where samples are being 
collected with non-standard media, or over unusual 
surfaces, or being tested with a laboratory which cannot 
supply extraction and detection efficiency factors.  In 
such cases, applying a collection method filter and analyzing the data for a single collection 
method in isolation can obviate the negative effects of these interferences. 
 

7.2.1.1.2. Sample Group Filter 

A sample set may be defined by specifying the sample 
groups.  Each sample’s database record has a group 
attribute.  A sample group is the set of samples having a 
common value in the group attribute.  As with collection 
methods, a sample group filter can be defined using 
multiple possible matches for group attribute (Figure 7-2). 
 
Sample group filtering is a principal means of restricting 
the population of a sample set.  The group attribute of a 
sample is automatically populated when it is collected.  
Users can interactively edit the group attribute through the 
property grid to quickly identify samples with certain 
characteristics to be included or excluded from analyses.  
The list of available groups is dynamically updated by 
BROOM as new group attribute values are added to the 
sample dataset. 
 

7.2.1.1.3. Sample Values Filter 

Sample sets can be filtered based on the numeric values they represent.  Samples with values 
below a lower limit and sample with values in excess of an upper limit can be excluded from a 
sample set (Figure 7-3). 

 
Figure 7-1.  Collection 

Method Filter. 

 
Figure 7-2.  Sample Group 

Filter. 
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This filter option is particularly useful for analysis 
codes which do not explicitly support input filtering by 
value.  Often sample datasets contain analysis blanks or 
other spurious items to be filtered.  Additionally, this 
option is well suited to eliminating outliers or 
questionable values.  When a lower limit and an upper 
limit are both included in a sample values filter, the 
effect is additive.  That is, the filter defines a between 
condition where samples greater than the lower limit 
and less than the upper limit are included in the sample 
set. 
 

7.2.1.1.4. Zone Sample Filter 

Characterization and decon zones 
define regions within the current 
building bounded by polygons. Zone 
sample filters select samples which 
are located within the polygons 
belonging to specified zones (Figure 
7-4).  Since zones can be defined 
with arbitrary shapes, the zone 
sample filter can be used to define 
ad-hoc spatial filters.  Temporary 
zones can be drawn to match the 
requirements for a unique sample set 
for a given analysis.  Applying a 
zone sample filter to this temporary 
zone then allows samples from arbitrarily shaped regions to be included or excluded from an 
analysis.  
 
7.2.1.2.  Sample Set Value Operators 

The quantity that is stored as the numeric value for each sample in the sample set is user 
configurable.  The sample set retains knowledge of the nature of the numeric values associated 
with each sample for later use by analysis and display processes. 
 

7.2.1.2.1. Value Source 

The value saved in the sample set can come from any of the three available sample value types: 
 

• Quantity Measured:  Contaminant level in the sample as reported by the laboratory 
• Surface Contamination:  Quantity measured corrected for surface area and sampling 

efficiency 
• Integrated Exposure:  Surface exposure corrected for differential settling rates 

 
 
 

 
Figure 7-3.  Sample Value Filter. 

 
Figure 7-4.  Zone Sample Filter. 
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7.2.1.2.2. Value Transform 

The value associated with each sample in a sample set can be transformed from the value that 
occurs in the sample dataset (laboratory results).  The available transform options are: 
 

• Log10:  Calculates the log10 result of the sample laboratory value and records that result 
as the sample set value. 

• Indicator:  Calculates a binary (0 or 1) value based on whether the laboratory value of a 
sample is above or below a user definable threshold level.  This binary value is then 
assigned to the sample set. 

 
7.2.2. Meshes 

Map-based analysis methods entail making estimates at a large 
number of regularly spaced locations within a building.  Simple 
rectangular grids are simple to generate and define, but real-world 
buildings are irregularly shaped.  The mesh generation tool in 
BROOM creates regular sets of points for analysis codes to operate 
on when making estimates.  The meshes also define the small 
polygons around the estimation points to assist the BROOM 
visualization system in creating accurate and pleasing maps of the 
analysis results.  An example of a floor-wide mesh is shown in 
Figure 7-5. 
 
7.2.2.1. Mesh Parameters 

Meshes are defined interactively by specifying the region the mesh 
is to cover, the size of the individual mesh cell and the shape of the 
mesh cell (Figure 7-6). 
 

7.2.2.1.1. Mesh Region 

Meshes must be limited to polygonal regions.  A single mesh can be defined by multiple 
polygons, and the polygons need not be contiguous.  Free hand, interactive sketching of mesh 
bounding polygons is not supported in BROOM.  Instead, meshes are defined based on the 
geometry of pre-existing building components (Figure 7-6).  Mesh regions can be based on: 
 

• The currently-selected room 
• All rooms on the current floor 
• The bounding polygon of the current floor 
• The currently-selected zone 

 
Figure 7-5.  Mesh 
Covering a Floor. 
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Of these options, only the All Rooms and Current Zone selections permit disjoint collections of 
polygons to define a single mesh.  Note that the mesh points within the wall cavities on the mesh 
created with the Floor Boundary option, but the mesh points are limited to the rooms leaving the 
cavities open when the All Rooms option is selected (Figure 7-7). 

 
Figure 7-6.  Mesh Definition Form. 

 
Figure 7-7.  Meshes Created with Different Region Options. 
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7.2.2.1.2. Mesh Cell Type 

BROOM meshes can be defined using rectangular or hexagonal cell shapes.  Different analysis 
codes into which the mesh feeds often require rectangular or hexagonal mesh inputs (Figure 7-8). 

 
7.2.2.1.3. Mesh Sizing 

The spacing between the mesh points or nodes can be specified either by count or by physical 
spacing.  The Node Count option subdivides the area covered by the mesh so as to make the 
maximum horizontal extent of the mesh contain the specified count of nodes.  If the Square 
Mesh option is enabled, the node spacing calculated for the horizontal dimension of the mesh is 
automatically applied to the vertical dimension.  The Node Spacing option simply takes the 
entered value and forces the nodes to be exactly that distance apart. 

 
Figure 7-8.  Mesh Cell Shapes. 
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7.2.3. Regions 

Many analysis codes require an area as an input, but not with the 
subsidiary nodes contained in a mesh.  Regions provide a 
general-purpose polygonal input for these analysis codes. 
 
Regions inherit pre-existing geometry (Figure 7-9).  Regions 
may be defined from: 
 

• The currently-selected room 
• All rooms on the current floor 
• The bounding polygon of the current floor 
• The currently-selected zone 
• The currently-selected boundary of a multiple-boundary 

zone 
 
Many analyses which generate proposed sample locations or 
other point-based output utilize region inputs. 

 
Figure 7-9.  Region 

Options. 
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7.3. Mapping Tools 

BROOM provides sophisticated methods for estimating contamination levels in a building based 
on existing samples and presenting those estimates as contaminant maps.  The three mapping 
methods offer different levels of automation and user interaction.  The available mapping 
methods are: 
 

• Inverse Distance:  Fast contaminant maps requiring minimal user input modeling 
• Kriging:  Higher quality maps requiring some knowledge of spatial correlation 
• Shortest-path kriging: Advanced method optimized for building interiors, requiring 

additional user inputs and considerable user training. 
 
7.3.1. Inverse Distance Mapping 

The inverse distance mapping tool provides a very fast method and reliable means for generating 
a contaminant map.  The technique generates a usable map with minimal user interaction. 
 
7.3.1.1. Inputs 

The inverse distance mapping tool (IDW) requires a sample set (see section 7.2.1) and a mesh 
(see section 7.2.2) as inputs.  These inputs are selected from the analysis inputs dialog in a 
manner consistent with all other BROOM analysis codes. 
 
7.3.1.2. Inverse Distance Map Preview 

Although a minimal number of inputs are needed to get a serviceable map using inverse distance, 
often the map is fine-tuned by altering some parameters.  BROOM provides an interactive dialog 
which displays an image of the inverse distance map created for the specified sample set and 
mesh along with three main controls.  These controls permit fine adjustment of the map image by 
interactively adjusting the parameters. 
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7.3.1.2.1. Inverse Distance Power 

Adjusting the Inverse Distance Power affects the contribution of sample points distant from the 
estimate point.  Powers higher than two (the default) tend to increase the contribution of closer 
points while minimizing the effects of more distant points.  Power values less than two make 
distant points relatively more influential.  Values near zero generate a map with uniform values 
near the mean value the samples.  In practice, power values between 2 and 3.5 seem to generate 
the most useful maps. 
 

7.3.1.2.2. Search Distance 

Changing the search distance (the Limit Search Neighborhood by Distance option) can improve 
map quality when an inverse distance map is looking “spotty” with strong concentric coloration 
patterns around samples.  Often the spottiness results from too large of a search distance.  The 
default search distance for the inverse distance mapping tool is the full spatial extent of the 
sample set.  Decreasing the search distance restricts the estimation calculation to samples within 
a smaller radius of the estimation point.  This often makes the spottiness or other artifacts 
disappear. 
 

7.3.1.2.3. Point Count 

Another method to force the estimation procedure to focus on sample points close to the 
estimation point is to restrict the number of sample points that it uses for calculating each 
estimate.  This is accomplished by modifying the Limit Search Neighborhood by Point Count 
option.  The default point count is the total count of points in the sample set.  By decreasing the 

 
Figure 7-10.  Inverse Distance Map Preview Form. 
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allowed point count to, say, 7 allows only the seven samples closest to the estimate point to be 
included in the estimate calculation. 
 

7.3.1.2.4. Output controls 

The remaining controls on the map preview dialog are simple output controls which determine 
the type of map plotted in the BROOM map window. 
 
7.3.2. Traditional Geostatistical Kriging 

7.3.2.1. Variograms 

Generally speaking, the level of contamination found at two samples is going to be similar for 
two samples near each other and less similar for two samples distant from one another.  A 
variogram is a model of this spatial correlation between samples.  An example of spatial 
correlation is shown in the contamination map in Figure 7-11.  Notice that for two points next to 
each other, their values (represented as a color) are similar. Yet, at greater distances, two points 
chosen at random typically have larger differences in value. 

 
7.3.2.1.1. Easy Variogram 

When analyzing a contaminated area for spatial correlation amongst the known samples, 
BROOM employs a tool called Easy Variogram for generating and fitting variograms.  Easy 
Variogram allows the user to describe how areas of contamination are related to each over a 
given space. 
 
The Easy Variogram GUI is designed to facilitate the geostatistical analysis and correlation 
modeling of spatial data sets.  It is a separate application that is launched from within BROOM.  
Easy Variogram computes empirical variograms of gridded or irregularly-spaced data. 

 
Figure 7-11.  Contamination Map. 
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A variogram requires one input, a sample set.  The space over which the variogram is generated 
is specified by the sample set.  See section 7.2.1 for more details about sample sets.  All other  

necessary inputs are automatically generated; however, they can be edited once the Easy 
Variogram GUI has launched.  A more detailed description of each parameter can be found in 
the next subsection.  The variogram modeling analyses may be conducted in 1, 2, or 3-
dimensional space.  Typically, the user will limit the modeling to one dimension for simplicity 
(effectively saying that the spatial correlation is the same in all directions), which is assumed to 
be the case for the Easy Variogram module. 
 
The input parameters (e.g., nugget, range and sill) for the variography have a significant effect 
on the predicted outcome of the spatial model.  Easy Variogram plots a variogram curve (the 
blue line shown in Figure 7-12) against the variogram calculated data points.  To make a long 
story short, this plot consists of points which will typically show a fairly apparent trend.  The 
user’s task is to fit a curve to these points, as shown in Figure 7-12.  The user can manually 
change the fit of the curve to the data in two distinct ways.  On the right side of the Variogram 
window are numerical inputs for the key parameters to a spatial correlation model (e.g., nugget, 
range, sill, lag spacing).  There are three types of spatial correlation models to choose from: 
spherical, Gaussian, and exponential).  Each of these spatial correlation models has a unique, 
characteristic shape for the variogram.  The second manual method to fit the curve is a click-and-
drag technique.  On the graph on the left side of the variogram window there are three of the 
parameters listed in red text, which are the Nugget, Range and Sill.  The user can click on one of 
these parameters and drag the arrow to change the shape of the curve.  The plot also shows the 

 
Figure 7-12.  Easy Variogram GUI. 
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overall sample variance as a horizontal line on the graph and the numerical value for the variance 
in green text.  The Sill parameter should typically be set to the sample variance value. 
 
In addition to the manual manipulation of the spatial correlation curve fit, the Easy Variogram 
has an option to automatically fit the three spatial correlation models to the spatial data.  Figure 
7-13 shows an example of this curve fitting option with the three curve fits in three different 
colors on the graph.  The legend in the graph shows the correlation coefficient for each curve fit 
(e.g., a goodness-of-fit indicator). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
7.3.2.1.1.1. Easy Variogram Inputs and Outputs 

• lag spacing: the unit lag separation distance.  
• nugget: the y-axis intercept of the spatial correlation model, a parameter that relates to 

the amount of uncertainty in close proximity to existing data points. 
• sill:  the asymptotic tail end of the spatial correlation model, a parameter that relates to the 

variance of the data set. 
• range: the point on the x-axis where the spatial correlation model changes in slope to the 

assumptote, a parameter that relates to the distance over which samples tend to be 
correlated in the data set. 

 

 
 

Figure 7-13. Spatial Correlation Model Fitting 
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7.3.2.2. Easy Kriging 

Kriging is a regression technique used in geostatistics to approximate or interpolate data.  Easy 
Kriging is a kriging package that allows BROOM to characterize a target region by generating a 
contamination map and uncertainty map.  The contamination map provides a color-coded display 
of the amount of contamination over a region.  Corresponding with the contamination map is an 
uncertainty map that provides the amount of certainty in the contamination estimates. 

 
The contamination map shown in Figure 7-4 displays areas of highest contamination in red and 
lowest in blue and violet.  This map is generated from a sample set and the variogram describing 
the spatial correlation amongst those samples.  A mesh is the third input for kriging.  The mesh 
defines the boundary and resolution of the contamination and uncertainty maps. 
 
The uncertainty map shown in Figure 7-15 displays, like the contamination map, areas of high 
uncertainty in red and low uncertainty in blue.  Note how the areas immediately surrounding 
each sample are blue—the closer you are to a known sample, the more confidence you can have 
in contamination map’s value at that point.  The further away you are from a known sample, the 
more uncertain you become. 
 
The space over which the kriging maps are generated is specified by the sample set, variogram, 
and mesh tabs, as seen in the figures above. The mesh may be derived from an assemblage of the 
room polygons, the boundary polygon, or a characterization zone polygon.  Section 7.2.2 
describes the options for generating a mesh.  Several parameters will control the size and shape 
of the mesh for generating contamination and uncertainty maps.  The number of nodes has a 
profound effect on the clarity of the color contour definition and how pixilated it might appear.  
The greater the number of nodes the smoother the color transitions and display but with the 
trade-off that it takes longer to process the geostatistical model calculations. Generally speaking, 
a node count of 150 in both the x and y directions yields smooth looking contamination maps.  
The Easy Kriging GUI is designed to facilitate the process of generating kriged data sets in 2 
dimensions.   
 
 
7.3.3. Shortest Path Kriging 

Kriging is an interpolation method used to generate contaminant maps from point samples.  
Kriging relies upon the distances separating samples to establish their spatial correlation which 
in turn is used to estimate contaminant values at unsampled locations.  In obstructed 

 
Figure 7-14.  Contamination Map. 

 
Figure 7-15.  Uncertainty Map. 
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environments, like the interior spaces of most buildings, the true distances between samples are 
not straight-line or line-of-sight distance.  Shortest path kriging is a new method which applies a 
graph algorithm to a bitmap image of the building interior to calculate the true distances between 
the samples.  Shortest path kriging can generate contaminant maps that more accurately represent 
contaminant levels in unsampled locations. 
 
7.3.4. An Example Dataset 

Samples of possible contaminants are collected at point locations within buildings.  Analytical 
results from these samples give an indication of what areas of the building are contaminated and 
to what extent.  When sufficient number samples have been analyzed, plotting the results on a 
map enables trends and hotspots to be spotted (Figure 7-134).  In the model building dataset 
shown below, high levels are observed in the east and north portions of the building and low 
values in the northwest and southeast rooms. The points displayed in Figure 7-136 represent a 
random subset of 20,000 points which constitute a simulated release of a bio-agent (Figure 
7-147). 

 

 
Figure 7-136.  Map with 70 Color-Coded Samples. 
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7.3.4.1. Applying Traditional Methods to a Dataset 

Kriging is a geostatistical method which generates estimates of levels at locations at which no 
samples were taken  Kriging numerically estimates not only the expected value of the quantity of 
interest, but also the variance of the measurement, giving us an indication of the uncertainty 
associated with the estimate.  Applying traditional kriging to a 70-point subset of the model 
dataset (Figure 7-136) produces a contamination map showing the extent of the contamination 
(Figure 7-8).  The field of the map is composed of approximately 20,000 square cells each 
measuring 50cm on a side.  Each cell is assigned a value corresponding to the amount of the 
contaminant that the kriging calculation determines is most likely to be present at that location 
given the spatial configuration of the sample points. 
 
Generating kriging maps represents a step forward in ease of interpretation from the color-coded 
dots in Figure 7-136.  Additionally, the interpolation maps allow deposition patterns to be more 
readily visualized. 

 
Figure 7-147.  Map Showing 20,000-point Dataset (Ground-Truth). 
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7.3.4.2. Challenges in Applying Kriging Indoors 

While kriging generates useful maps of indoor 
contamination levels, indoor building geometry 
complicates their interpretation.  Geostatistical 
analyses such as kriging rely upon the distance 
separating sample points to determine their spatial 
correlation.  This spatial correlation in turn 
determines the values assigned to cells for which 
sampled values are not available.  Building interiors 
are challenging environments for geostatistical 
analysis since walls, doors, and ventilation systems 
introduce spatial non-uniformity. 
 
The problem can be thought of as finding the distance 
between two locations in two adjacent rooms (Figure 
3).  The resultant true shortest path distance must 
include the distance from the first point to the door of 
the first room, the distance between the doors of the two rooms and the distance from the door of 
the second room and the second point.  A traditional kriging estimation involving the two green 
points in Figure 7-19 would use the length of the red line as the distance used to determine the 
effect of a measured value at one green dot to an estimate being calculated at another green dot.  
Using the true shortest path distance, the length of the blue path, should give a more realistic 
estimate of the true spatial relationship of the two green points and thus a higher quality estimate. 
 

 
Figure 7-18.  Traditional Kriging Map (Ignores Walls). 

 
Figure 7-19.  Distance Relationships 

Between Samples. 



119 
 

7.3.4.3. Shortest Path Kriging Methods 

We have developed methods to calculate these non-Euclidean distances in building models.  The 
methods rely upon Dijkstra’s algorithm, one of the foundation algorithms of graph theory.  In our 
application, a bitmap image of the floor plan of the building model is used as “Distance Mask” 
(Figure 7-20).  The graph algorithm operates between sample points on this bitmap image to 
determine the shortest paths which do not cross building components such as walls and 
partitions.  The distances along these computed shortest paths can be substituted for the simple 
straight-line distances traditionally used by geostatistical methods such as kriging to generate 
contamination maps. 

 
When these corrected distances are fed into the kriging processes, a much different map is 
generated (Figure 7-21).  The non-Euclidean distances produce color gradations that respect the 
interior arrangement of the interior partitions.  In particular, the small room in the northwest 
corner of the building shows distinct offset of the color gradients across its southern partitions.  
Similarly, the small room in center-southwest portion of the map which has no door to connect it 
to the rest of the building is shown to be isolated from the rest of the building, with estimates of 
zero inside the building and greater than zero outside. 

 
Figure 7-20.  Floor Plan Used as a Distance Mask. 
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Maps generated from shortest path distances visually agree with expectations for contaminant 
level patterns in and around impermeable interior partitions.  The deposition patterns represented 
in Figure 7-21 are qualitatively plausible; contaminant levels vary sharply across walls, but 
smoothly across open doorways. 

 
7.3.4.4. Shortest Path Variance Maps  

Variance maps show the influence that correcting distance values for building geometry has 
upon the uncertainty of estimates.  The standard kriging variance of the model data set is shown 
in Figure 7-22. 

 
Figure 7-21.  Shortest Path Kriging Map. 

 
Figure 7-22.  Variance Map Created by Traditional Kriging. 
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Applying corrected distances yields a somewhat different picture of estimated uncertainty.  
Figure 7-153 shows the variance map for the model data set obtained by shortest path kriging.  
Zones of elevated variance are shown in a corner of the large southwest room, in the corner of 
the north-central room adjacent to the sealed room and at the south end of the central hallway.  
These areas of high uncertainty are all characterized by having samples close to them, but on the 
opposite side of a partition. 

 
The capacity of shortest path kriging to delineate these zones of elevated uncertainty could have 
implications to sample placement considerations.  When using a map of kriging variance to 
guide optimum sample placement, standard kriging variance maps may overstate the confidence 
with which estimates are known in areas where interior partitions are found. 
 
7.3.4.5. Mass-Balance Calculations  

The geostatistics-based analysis system in the BROOM system permits estimated values to be 
assigned to unsampled areas cells within a building.  The contaminant values in each of these 
cells can be summed to give an estimate of the total amount of contaminant present in the 
facility.  Since this building model represents a sampled subset from a synthetic dataset, we can 
compare the kriging methods in BROOM to see how well each reconstructs the actual amount of 
material present in the model (Table 7-1). 

 
Figure 7-153.  Variance Map Created by Shortest Path Kriging. 
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In this example, all kriging methods underestimate the amount of contaminant present in the 
building.  Of the methods, the two shortest path methods came closest to the ground-truth values.  
Surprisingly, the method with the integrated total closest to the ground truth was run with the 
smaller distance-mask bitmap.   
 
It is notable that the integrated totals for all kriging methods are as close to the ground-truth 
value as they are, given the size of the dataset.  The 70 samples selected represent 0.35% of the 
20,000 cells of the ground-truth dataset. 
 
7.3.4.6. Comparison of Kriging Methods 

The maps generated with shortest-path kriging follow the interior building geometry more 
closely than the maps generated by standard kriging techniques and thus would appear to 
produce more accurate estimates of contaminant levels. 
 
To test the quality of the kriging estimates, maps were generated from the model data set using 
both methods.  Randomly selected sample sets of 50, 62, 70, 125, 250, 500 and 1,000 data points 
were extracted from the model dataset. Each sample set was mapped with each kriging method.  
The estimates obtained in each of the 20,080 cells of the map were then compared with the 
ground truth values.  Mean square error, average error, and correlation coefficients were 
calculated to show how well traditional kriging estimates agreed with ground truth and how well 
shortest path kriging estimates agreed. 
 
Results for the correlation coefficient are is graphed in Figure 7-164.  These results suggest that 
estimates obtained from the shortest path method maintain their agreement with actual values 
better at lower sample counts than do estimates obtained from standard kriging methods. 

Table 7-1.  Integrated Contaminant Estimates. 
 

 

Model 
Max Cell 

Value 
Mean Cell 

Value 
Standard 

Dev 
Integrated 

Total 

Accuracy vs 
Ground 
Truth 

 Ground Truth 
(Figure 1) 

2,367 122 280 613,000 100% 

 Standard Kriging 
(Figure 2) 

1,234 60 147 300,000 49% 

 Large Distance Mask 
(Figure 5) 

1,510 94 221 470,000 77% 

 Small Distance Mask 
(Figure 6) 

1,852 208 258 537,000 88% 
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An alternate view of the estimates made by the two methods is shown in the plot of average 
estimation error in Figure 7-175.  The magnitude of the average error generally decreases with 
larger number of samples.  At smaller sample numbers, shortest path kriging appears to generate 
estimates which are closer to the true value. 

 
Shortest path kriging shows promise of increasing the accuracy of estimated contaminant levels 
inside buildings.  Applying simple graph algorithms to the floor plans of buildings permits true 
distances separating the samples to be calculated.  The contamination maps generated from this 
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Figure 7-164.  Correlation Coefficient Values of Estimated and Actual 
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Figure 7-175.  Average Kriging Estimate Errors. 
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model data set indicate that shortest path kriging produces maps that are more accurate than 
maps produced by standard kriging methods. 
 
7.3.4.7. Distance Mask 

The distance mask used in shortest path kriging is a simple bitmap image file.  Any available 
image file which pictures the facility of interest can be used for the distance map.  Supported 
formats include jpg, gif and bmp.  The convention used for interpreting a distance mask image is 
that a white or light colored area is open space and a black or dark area is a barrier.  Thus, a 
black line across a white area can model a wall separating two open rooms.  An open doorway 
can be created in the wall by simply erasing a segment of the line where the door is located. 
 
As an alternative to importing bitmap images files of the facility, BROOM can generate distance 
mask image files interactively by capturing the current map panel display on screen.  The 
distance mask user interface contains a button for generating the image directly from BROOM.  
The dialog also presents controls to allow editing of the image (Figure 7-6).  These interactive 
editing features for distance masks are 
quite useful for quickly modeling the 
potential effects of changes in 
configurations of a facility.  The effects 
of opening and closing doors, movable 
partitions, on contaminant distribution 
patterns can be evaluated by editing the 
distance map bitmaps to add or delete 
the features of interest and then running 
the shortest path kriging analysis on the 
modified distance mask. 
 
Figure 7-26 shows an example of how 
simple editing of a distance mask 
changes the map generated from shortest 
path kriging.  When no black lines exist 
within the building outline as shown in 
the upper left example, the map 
generated shows concentrations 
changing smoothly across the map (lower left).  When the interior walls are drawn in the 
distance mask, but no communicating passageways exist (upper center), concentrations change 
smoothly within each room, but sharp estimated concentration differences are seen between 
rooms.  In the third example, the distance map was modified by adding two doorways.  The map 
in the lower right of Figure 7-7 shows that estimated concentrations in the southern part of the 
northeast room have increased substantially compared to the map with no doorways (lower 
center).  With no doors, all estimates within the northeast room were based only on the two 
relatively low-level samples within the room.  Once the doors to the room are open, the kriging 
procedure can use the higher values from samples in adjacent rooms when estimating the most 
likely contaminant levels within the northeast room. 

 
Figure 7-26.  Distance Mask User Interface. 
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7.4. Sample Design Tools 

BROOM includes a number of tools to facilitate design and implementation of sampling plans 
for a contaminated facility.  Statistical methods exist to determine how many samples are needed 
to adequately characterize a facility to a given confidence level.  Most of these methods make 
assumptions about the samples or the distribution that may not be applicable.  BROOM provides 
a conservative nonparametric procedure which to generate the number of samples.  Once this 
minimum number of samples is determined, BROOM provides interactive tools to quickly lay 
out the samples across the facility. 
 
7.4.1. One-Sample Sign Test 

BROOM uses the one-sample sign test to determine a suggested minimum number of samples to 
be taken from a particular part of a facility.  The one-sample sign test makes no assumptions 
about the distribution of sample values being normal or symmetric.  The one-sample sign test 
does assume that the contaminant is not present in background (Reference to MARSSIM). 
 

 
Figure 7-27.  Distance Mask Effects on Contaminant Map. 
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7.4.1.1. Inputs 

The sign test procedure requires inputs that may specific to the site and to the contaminated 
facility.  Allowable error levels are independently set for Type I (false positive) and Type II 
(false negative) errors (Figure 7-8).  The action level corresponds to the level at which the area or 
zone as a whole is considered to be contaminated.  The lower bound corresponds to the 

permissible amount of contaminant allowed.  This parameter is open to some interpretation 
(marsim gogolak reference).  The lower bound parameter has often been set to one-half of the 
action level.  Another reasonable value for the lower bound is the detection limit of the collection 
of laboratory method being used to generate the sample values.  The standard deviation value can 
be derived from previous work with the chosen method, or by blanks, spiked samples, or closely-
spaced sample arrays collected during initial phases of sampling.  The procedure calculates a 
minimum number of samples required to meet the parameters entered. 
 
7.4.2. Random Sample Layout 

BROOM provides an easy-to-use tool to generate randomized layouts of prospective sampling 
locations.  The inputs are simply a BROOM region describing the area to cover with the samples 
and the number of samples desired.  Proposed sample locations are randomly generated as 
specified.  These locations can be viewed on the map and sent to the PDA for collection by the 
sample teams. 
 
7.4.3. Grid Sample Layout 

Many sampling strategies require a regular pattern of samples.  BROOM helps generate regular 
samplings grids at user specified densities.  Users may choose many alternative grid layouts 
before committing on one to apply to a sampling plan (Figure 7-). 

 
Figure 7-28.  Inputs to MARSSIM Sign Test. 
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7.4.3.1. Inputs 

The principal inputs to the grid sampling tool concern grid geometry and density.  Triangular and 
rectangular grid styles are available.  Density can be specified as either the count of desired 
samples within the sampled region, or as the desired spacing between samples.  By default, the 
sample grid’s origin is centered in the sampled region.  Alternative placement options, such as 
random origin or user-defined sample origin permit flexibility in laying out the grid.  The angle 
of the grid can be adjusted by the user to account for building components which are not aligned 
orthogonally with the building model axes. 
 
7.4.3.2. Sample Grid Generation 

The tool provides two methods for generating the sampling locations based on the input 
parameters.  The Generate from Desired Spacing option creates a grid based on the current 

 
Figure 7-29.  Grid Sample Layout Interface. 
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spacing, angle and origin inputs.  This option efficiently creates a grid which is displayed as pink 
points on the map.  The count and spacing of the resulting grid are displayed on the dialog in red 
(Figure 7-). 
 
The grid sampling tool applies an optimization to the sampling grid when the Generate from 
Desired Count option is selected.  With this option, the tool varies the grid spacing in an attempt 
to create a grid with exactly the number of samples matching the current desired count input.  
Often, no grid exists which will place the exact desired count of samples in the sampled region 
using the current settings for grid origin and grid angle.  In this instance, the optimizing routine 
will create a grid with a count as close as possible to the desired count. 
 
Regardless of the method used to generate the grid, choosing a new origin or angle creates a new 
grid.  Entering new values for the grid angle or origin triggers the tool to automatically 
recalculate the grid and display it on the map.  Often, if the first attempt at generating a grid with 
the desired count of samples in a region is not successful, simply choosing a new random grid 
origin will create a grid with the desired configuration. 
 
7.4.4. Stratified Random Sample Layout 

Random sample layout often generates patterns with large areas of the sampled region not 
covered.  Stratified random sampling combines elements of gridded methods and random 
methods to generate randomized sampling designs which have more regular and predictable 
spatial coverage than simple random approaches. 
 
Stratified random sampling first subdivides the sampling region into an array of discrete areas or 
strata which are evenly distributed throughout the region.  Then a sample location is located at a 
random point within each stratum.  This approach guarantees samples are relatively well 
distributed throughout the sampling region, but not requiring the rigid periodicity of the griddid 
approach. 
 
BROOM’s stratified random sample layout user interface (Figure 7-) closely resembles that for 
grid sample layout (Figure 7-).  The concepts governing the size and placement of the strata are 
similar to those needed to specify a sampling grid.  The grid lines drawn on the map during 
interactive stratified random layout delineate the boundaries of the strata.  The pink dots occupy 
random locations within the strata. 
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The degree of randomness of a sample point within a stratum can be assigned by the user.  At 
100% randomness, the sample is equally likely to end up anywhere within the stratum.  At zero 
percent randomness, the sample is placed in the exact center of the stratum (Figure 7-).  At 
intermediate values, the sample is randomly placed within the stratum with a variable degree of 
central tendency.  The sample location is determined by a Gaussian normal distribution; 
increasing the randomness value with the dialog control corresponds to broadening the 
distribution by increasing its standard deviation.  The schematic probability plots in Figure 7- 
show that the probability function for the sample placement within a stratum with a 0% 
randomness setting is a spike at the center of the stratum cell indicating that the probability of 
placement at the center of the cell is 1.0.  At the other extreme, the 100% randomness schematic 
probability plot shows that the probability of sample placement is the same anywhere across the 
width of the sample stratum.  At 50% randomness, samples are more likely to be placed near the 

 
Figure 7-30.  Stratified Random Sample Layout Interface. 
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center of the stratum cell, but a finite probability exists that a sample can be placed near the edge 
of a stratum.  This range of pattern choices gives the analyst flexibility to balance the needs for 
spatial cover and randomness when designing the sample plan for a specific facility. 

 

 
Figure 7-31.  Effect of Randomness on Stratified Random Sample Layout. 
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7.4.5. Sampling Optimization 

The sampling design tools within BROOM are based on the concept of adaptive sampling where 
some information has already been collected and the locations of additional samples need to take 
into account that existing information.  The geostatistical mapping features within BROOM can 
provide spatial estimates of concentrations, uncertainty inherent in those estimates and/or the 
probability of exceeding a specified threshold concentration at any location.  These spatial 
estimates are maps that serve as input to the optimization tools.  As an example, additional 
samples could be acquired in areas of high estimated concentration and high uncertainty through 
the definition of an objective function that incorporates these two objectives: identify high 
concentration areas and sample where the uncertainty is the greatest.   
 
The BROOM software provides two different options for creating an optimal sampling design.  
Here, sampling design is defined as the spatial arrangement of the samples within the building 
and does not directly address the choice of the sample type (e.g., vacuum vs. swab) or the type of 
analyses done on those samples.  Optimal sampling designs are those that minimize some 
quantifiable objective function.  Within BROOM, different objective functions can be created to 
achieve different sampling goals and these objective functions can be combined for multi-
objective optimization.  Two different optimization schemes, simulated annealing (SA) and the 
Probabilistic Adaptive Sampling Technique (PAST), are included within BROOM.  Each 
optimization scheme is a heuristic optimization tool in that the final sampling design(s) are not 
mathematically provable as being the optimal designs.  However, the final designs do meet some 
user-specified thresholds defining the degree to which the initial value of the objective function 
has been decreased or the total number of different sampling designs that have been evaluated.  
 
In general, the major differences between the SA and PAST algorithms are that SA optimizes a 
single design at a time while PAST optimizes a population of designs simultaneously.  SA is 
typically applied to discrete optimization problems (e.g., the spatial arrangement of samples on a 
predefined grid). PAST utilizes Monte Carlo simulation to address uncertainty in the mean, 
variance and probability fields.  As implemented in BROOM, the SA algorithm uses previously 
calculated maps as the input and does not change these during the simulation.  These maps can 
be thought of as response surfaces for providing input to the function evaluations.  Within 
BROOM, the PAST module has been coded to work with the Sequential Gaussian Simulation 
(SGSim) geostatistical simulator. 
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7.4.5.1. Simulated Annealing 

Simulated annealing (SA) is a generic probabilistic 
algorithm for completing combinatorial 
optimization.  Different from gradient-based 
optimization algorithms, SA optimizes the 
combination of a finite number of objects in a large, 
but discrete, configuration space.  SA is a good 
approximation for locating the global optimum of a 
given function in a large search space.  Within a 
given SA method, each point of the search space is 
compared to a state of some physical system, and the 
objective function to be minimized is interpreted as 
the internal energy of the system in that state. This 
energy is a numerical analogy to the free energy in a 
physical melt where the goal is to cool the melt 
slowly such that the optimal crystalline 
configuration is reached.  Numerically, the goal is to 
bring the system, from an arbitrary initial state, to a 
state with the minimum possible energy.  In 
sampling design, the goal is to find the optimal 
configuration of N samples on a grid containing 
1000’s of potential sample locations on a predefined grid.  Typical optimization goals are to 
simultaneously reduce uncertainty and to bound the extent of contamination that exceeds some 
threshold value. 
 

At each step, the SA algorithm considers some 
neighbor of the current state s.  SA then makes a 
probabilistical decision between moving the system 
to the new state s' or staying put in the current state 
s.  The probabilities are chosen so that the system 
ultimately tends to move to states of lower energy.  
Typically, this step is repeated until the system 
reaches a state that is good enough for the 
application, or until a given computation budget 
has been exhausted.  The probability of making the 
transition from the current state s to a candidate 
new state s' is a function of the energies of the two 
states, and of a global time-varying parameter T 
called the temperature.  
 
The SA user interface provides two tabs for 
defining conditions for optimization:  Basic and 
Advanced.  The Basic tab allows the user to select 
the number of newly proposed samples, as well as 
the weights (corresponding to importance) for 

 
Figure 7-32.  Simulated Annealing 

Interface. 

 
Figure 7-33.  Simulated Annealing 

Interface. 
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minimizing kriging variance and finding high contamination areas.  The Advanced tab allows 
many objective functions to be defined, which are described in more detail below. 
 

7.4.5.1.1. SA Objective Functions 

• Angle: The angle objective is minimized by placing samples around a center location 
(Center X, Center Y) such that the differences in the angles formed between adjacent 
points and the center location are minimized.  

o Center X: X-axis coordinate of the center location. 
o Center Y: Y-axis coordinate of the center location. 
o Weight: is a constant multiple applied to this objective function 

• Covariance Max: The Covariance Max objective is maximized when the weighted 
average of the map data within the elliptical variogram surface (defined by the 
parameters below) is maximized.  The weights applied to each map value are derived 
from the complement of the variogram function and are the spatial covariance values.  
Points falling within the variogram ellipse, but outside of the map boundaries are set to 
the lowest value in the map domain. In application, covariance max function is 
minimized by taking 1/max.  Its opposite objective function is Covariance Min.  More 
information on the variogram parameters can be found in Deutsch and Journel, 1998. 

o Anis: Range*Anis is length of the minor axis of the ellipse 
o Dimension: the index of the map column that defines the data set 
o Direction: gives the orientation/rotation of the major axis of the ellipse (0 north – 

180 south) 
o Function: Defines the variogram function: 1-spherical, 2-exponential, 3-gaussian, 4-

power 
o Range: length of the major axis of the ellipse 
o Sill: Sill1+Sill2+Nugget = 1.0 define the height of the ellipse at different distances 

from the center. 
o Weight: is a constant multiple applied to this objective function 

• Covariance Min: The Covariance Min objective is minimized when the weighted average 
of the map data within the elliptical variogram surface (defined by the parameters below) 
is minimized. Points falling within the variogram ellipse, but outside of the map 
boundaries are set to the largest value in the map domain. More information on the 
variogram parameters can be found in Deutsch and Journel, 1998.. 

o Anis: Range*Anis is the length of the minor axis of the ellipse. 
o Dimension: the index of the map column that defines the data set 
o Direction: gives the orientation/rotation of the major axis of the ellipse (0 north – 

180 south) 
o Function: Defines the variogram function: 1-spherical, 2-exponential, 3-gaussian, 4-

power 
o Range: length of the major axis of the ellipse width of oval 
o Sill: Sill1+Sill2+Nugget = 1.0 define the height of the ellipse at different distances 

from the center. 
o Weight: is a constant multiple applied to this objective function 

• Difference: The difference objective is minimized when sample locations are chosen such 
that the difference between the map values at those locations and a prescribed value are 
minimized.  . 



134 
 

o Dimension: the index of the map column that defines the data set   
o Value: the constant target value constant to which other points will be compared.   
o Weight: is a constant multiple applied to this objective function  

• Difference Over Area: The difference over area objective is minimized when sample 
locations are chosen such that the difference between the average values within a given 
radius around the sample locations and the prescribed value are minimized. This is 
essentially the same as the Difference function, but operates on a simple spatial average 
centered on each sample location, not just the actual sample point. 

o Dimension: the index of the map column that defines the data set   
o Radius: the radius of the circle that defines which points to be averaged 
o Value: the constant target value to which other points will be compared  
o Weight: is a constant multiple applied to this objective function  

• Distance: Similar to spatial cover, but without the edge boundary condition. The distance 
objective is minimized by maximizing the sum of Euclidian distances between all points. 

o Weight: is a constant multiple applied to this objective function  
• Equidistant: Similar to spatial cover, but only to nearest neighbor. The equidistant 

objective is minimized by maximizing the sum of Euclidian distances to the nearest 
neighbor (nearest point or border of domain). 

o Weight: is a constant multiple applied to this objective function  
• Equidistant Border Exist: This objective is minimized when oval shaped variograms 

(defined by function, range, sill) overlap most with the smallest values on the map. Points 
outside the map are set to the largest value in the domain 

o Anis: Range*Anis is height of oval 
o Dimension: the index of the column that defines the data set   
o Direction: gives the orientation/rotation of the oval (0 north – 180 south). 
o Function: 1-spherical, 2-exponential, 3-gaussian, 4-power 
o Range: width of oval 
o Sill: Sill1+Sill2+Nugget = 1.0 
o Weight: is a constant multiple applied to this objective function  

• Line of Sight: The line of sight objective requires that topographic elevation be one of the 
map data columns.  This objective is minimized by constructing a minimum spanning 
tree where the edge weights in the tree are determined by line of sight connections.  The 
edge weight is equal to minimized if the two locations have a line of site connection and 
equal to the amount of land above the straight-line connecting the two points if they do 
not have line of site connection.  . When all points have line of site communication, the 
objective is minimized. Edge weight between two points, P1 and P2, is calculated by 
integrating the area above the straight line. 

o Dimension: the index of the map column that defines the data set   
o Weight: is a constant multiple applied to this objective function  

• Mean: The average value of a data set (defined by dimension) is minimized. This is 
equivalent to choosing the minimal values of a data set.   

o Dimension: the index of the map column that defines the data set   
o Weight: is a constant multiple applied to this objective function  

• Redundancy: This objective ensures that line of sight connections are maintained in the 
case of partial failure (removal) of one or more sample locations. This objective only 
ensures that each node has multiple line of sight links to adjacent nodes. It does not 
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ensure that global line of sight across all sample locations will be maintained in case of 
sample failure (removal). An Example of failure is with two strongly connected sub-
graphs with a bridge between them. 

o Dimension: the index of the map column that defines the data set   
o MinSight: the minimum number of line of sight connections between each data 

point and others 
o Weight: is a constant multiple applied to this objective function  

• Spatial Cover: Similar to distance, but with edge boundary condition. The spatial cover 
objective is minimized by maximizing the Euclidian distance from each sample location 
to all other sample locations points and the nearest location of the domain edge boundary. 

o Weight: is a constant multiple applied to this objective function  
• Standard Deviation: The standard deviation of a data set (defined by dimension) is 

minimized. 
o Dimension: the index of the column that defines the data set 
o Weight: is a constant multiple applied to this objective function  

• Value Constraint: Ensures that points are bounded by the low and high value in a defined 
data set (defined by dimension).  While labeled as a constraint, this is actually an 
objective where the objective is minimized by keeping all sample locations within the 
High/Low limits defined. 

o Dimension: the index of the column that defines the data set   
o High: the maximum value for each sample data point 
o Low: the minimum value for each sample data 
o Weight: is a constant multiple applied to this objective function  

• Variance: The variance of a data set (defined by dimension) is minimized.  
o Dimension: the index of the column that defines the data set   
o Weight: is a constant multiple applied to this objective function  

• Variogram: The variogram objective places an elliptical variogram surface at the center 
of each sample location.  This function is minimized when the amount of weighted (by 
the covariance) overlap between adjacent sample points is minimized.    This objective 
has similarities to the Covariance Min and Covariance Max objectives.   

o Anis: Range*Anis is length of minor axis of ellipse 
o Dimension: the index of the map column that defines the data set   
o Direction: gives the orientation/rotation of the major axis of the ellipse (0 north – 

180 south). 
o Function: Defines the variogram function: 1-spherical, 2-exponential, 3-gaussian, 4-

power 
o Range: length of minor axis of ellipse 
o Sill: Sill1+Sill2+Nugget = 1.0 define the height of the ellipse at different distances 

from the center 
o Weight: is a constant multiple applied to this objective function  

 
7.4.5.2. Probabilistic Adaptive Sampling Technique - PAST 

The primary benefit to the PAST method for optimizing characterization sampling is the 
application of a geostatistical analysis method. Unlike traditional statistical methods, 
geostatistics can be used to model the spatial correlation of existing data, thereby producing a 
representation of spatial variability throughout the domain of interest. Some amount of data is 
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needed to begin an analysis using geostatistics. It is recommended that at least 20 or 30 randomly 
placed samples be collected prior to beginning a geostatistical analysis. 
Once a set of data is acquired, a variogram analysis is conducted that models the spatial 
correlation of the data. There are several common spatial correlation models available to fit to 
the observed data. These include spherical, Gaussian, and exponential models. A spherical model 
works well most of the time. Figure 7-34 shows an example of a variogram fitting analysis. It is 
also possible that the data may need to be transformed to obtain a reasonable variogram fit to a 
spatial correlation model. Log transformations may be employed when the range of the data is 
over multiple orders of magnitude. At times, the data are not spatially correlated, and the 
variogram analysis will not provide a good fit to the observed data. In these instances, it may not 
be advisable to use a geostatistical approach because the data are not correlated. 
 

 

Figure 7-34: Example of a Variogram Analysis 

Once a variogram analysis has been completed, a geostatistical model is employed to estimate 
the spatial distribution. There are many options for geostatistical models. The most common 
application of a geostatistical model is kriging. Kriging estimates the mean spatial distribution of 
the data as well as a variance estimate (i.e., a measure of uncertainty). Another geostatistical 
technique that can be used involves simulation. This method is called Sequential Gaussian 
Simulation, or SGSim. With SGSim, the user specifies a number of realizations to simulate and 
the code produces those variations of the spatial distribution. Each realization honors the values 
of the known data points but projects a different spatial distribution between data points that still 
meets the variogram specifications. With SGSim the user can get an appreciation for the amount 
of variability that might exist in the spatial distribution between known data points. From the 
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multiple realizations produced by an SGSim analysis, an estimate of the spatial distribution of 
the variance can be made. In addition, if the user specifies a concentration of interest, a 
probability of exceeding that concentration can be estimated throughout the area of interest. A 
probability plot is quite useful when evaluating the variability and uncertainty in the cleanup 
area, if the concentration specified was a preliminary remediation goal based on a risk 
assessment. The PAST method employs the SGSim model to take advantage of the probability 
estimates, as well as the variance. Many of the geostatistical models are available from Deutsch 
and Journel (1998).  
 
The optimization algorithm developed for the PAST method is designed to reduce the 
uncertainty in the area defined by a user-specified concentration threshold (e.g., a cleanup 
guideline). The user needs to supply several parameters associated with the objectives of the 
optimization. First the user defines the concentration threshold of interest. Next the user defines a 
probability of exceedance range within which a search routine will function. By example, the 
user might specify a probability band of 0.70 to 0.99 to conduct a search, meaning that the spatial 
distribution of contamination is 70% to 99% likely to exceed the specified concentration 
threshold. The user then supplies a distance measurement that corresponds to a minimum 
distance between adjacent sampling points. This is a constraint objective. The intent of this 
objective is to prohibit the search algorithm from specifying a dense congregation of sampling 
points that would not add significant value to the spatial distribution prediction. The reason that 
the search algorithm could return densely populated sampling locations is that it is searching for 
the locations where the variance is highest, which implies that the uncertainty is highest. The 
PAST method seeks to reduce uncertainty, so locating samples where the variance is highest will 
reduce uncertainty. Finally, the user specifies the number of potential sampling sites that will be 
identified for this round of the iterative sampling protocol. At the end of each sampling iteration, 
the geostatistical tools are used to estimate the cleanup area defined by the user-specified 
concentration threshold. A standard deviation of the cleanup area is also calculated. The user 
then decides whether to do another round of sampling based on the difference in the cleanup area 
and its uncertainty from the last iteration of sampling. The user may decide that a 5% difference 
is acceptable and that no further improvement in the estimate of the cleanup area is warranted, 
and a decision based on this state of information can be made. Figure 7-35 shows decision logic 
for implementing the PAST method. In summary, the PAST method is searching for a specified 
number of new sampling locations that will reduce the uncertainty in the spatial distribution of 
the user-specified concentration threshold.  
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User defines the following:

Data Quality Objectives; the number of initial random 

samples to be selected; and decision rules

Locations of the random samples are 

defined , samples collected, and results reported

The data are analyzed with a variography

routine to quantify the spatial correlation. 

The variography data is used in a Sequential Gaussian 

geostatistical simulation model to develop maps of

spatial variability, uncertainty, and the probability 

of exceeding a user-specified concentration threshold.

Statistics are compiled on plume characteristics.

Evaluate statistics against the decision rules 

(e.g., area of contamination well defined or still

significant uncertainty)

Are more samples 

needed to meet 

decision criteria

Use optimization routine to select new 

sampling locations.  Collect additional samples, 

analyze, and report results.

STOP

No

Yes

 

Figure 7-35: Decision Logic for PAST 

In order to demonstration the application of the PAST method, a case study was needed. A lead 
contaminated site at SNL was selected to evaluate the PAST method. The site was characterized 
extensively under regulatory oversight from the EPA, thereby providing a good comparison to 
the proposed PAST method. The site was approximately 5 acres in size.  The EPA prescribed 2 
rounds of sampling: a star pattern and a grid pattern.  The EPA was not satisfied until 350 
samples were collected.  No statistical measures were employed at the time to define the 
adequacy of sampling.  Figure 7-36 shows the sampling results from the EPA endorsed sampling 
scheme. 
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Figure 7-36.  Sampling results for lead contaminated site  

A geostatistical analysis was performed on the lead site data on a 12 meter grid resolution. The 
spatial concentration map (Figure 7-37) was assumed to be a baseline for querying concentration 
data for the PAST evaluation. 
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Figure 7-37.  Geostatistical mapping results for lead contaminated site  

The PAST method begins with a prescription for an initial round of sampling. Twenty five (25) 
samples is generally considered a minimum dataset to begin a spatial analysis.  A stratified 
random approach was used to designate the locations for the first 25 sampling points, whereby a 
grid is established and within each grid cell a random location is selected. The baseline spatial 
dataset is queried for the concentrations at each of the 25 sampling locations.  Next, a 
variography analysis is performed to model the spatial correlation of these data.  Sequential 
Gaussian Simulation (SGSim) is performed to predict the concentration distribution and variance 
distribution. A risk-based concentration threshold of 300 parts per million (ppm) has been 
established by the EPA, which is used to estimate a probability map for the PAST method. The 
user also specifies a minimum distance between sampling points when estimating new sampling 
locations.  

Next, the user specifies the number of samples they want to collect for the next round of 
sampling. Because the SNL robotics platform can only collect 6 samples at a time, the number of 
samples for each sampling round was set to 6 to evaluate the burden on the robotic deployment. 
Each round of sampling is culminated with an analysis of the data and a prediction of the next 
round of sampling locations. The area of contamination that is greater than the concentration 
limit for lead in soil was used as the metric to evaluate the performance of the method. 

The baseline dataset has an area of 14,800 m2.  PAST uses the variance distribution and a user-
specified probability band to select new sampling locations.  Figure 7-38 shows the variance 
distribution (an expression of uncertainty) and Figure 7-39 shows the spatial distribution of the 
probability of exceeding the risk-based threshold, 300 ppm. 

 



141 
 

 

Figure 7-40.  Variance mapping results for lead contaminated site  

 

Figure 7-39.  Probability mapping results for lead contaminated site  

The iterative procedure for evaluating new rounds of sampling was continued until a total of 140 
samples were collected.  Figure 7-40 shows results of the estimated area that is greater than or 
equal to the 300 ppm concentration limit for each round of sampling. 
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Figure 7-40.  Plume statistics for sampling iterations for lead contaminated site  

The PAST method defined the extent of contamination within the risk-based limit with ~60 
samples compared to 350 samples with a conventional EPA approach.  Clearly the PAST method 
has the ability to optimize sampling requirements.  Figure 7-41 shows the final results of the 
plume mapping with 60 samples. 
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Figure 7-41.  Geostatistical mapping results using PAST for lead contaminated site  

The geostatistical simulation technique estimates concentrations in a grid. A mass estimate can 
be derived for each grid cell based on the predicted concentration for each grid, then summed to 
get a total mass estimate. This estimate is dependent on an assumption of the thickness of the 
contaminated soil. Assuming a 1 inch thick layer of contaminate soil, this test site has 
approximately 1M kg of lead throughout the whole area, and about 0.8M kg that is over the 
300ppm limit. 

7.4.5.2.1. PAST Functionality in BROOM 

In order to use the PAST routine in BROOM, the user must first create a rectangular 
characterization zone of interest in which they wish to have the sampling optimization 
performed.  Once a characterization zone is defined, it is recommended that a stratified random 
sampling design be invoked to establish the locations of the first round of samples.  A stratified 
random approach distributes samples throughout the zone of interest, which should lend better to 
establishing the spatial correlation attributes of the data and to preclude any areas from 
exclusion.  To be statistically representative, a minimum of twenty five (25) samples is 
recommended for the first round of sampling.  Once those samples have been collected, 
analyzed, and the results imported into BROOM, a Sample Set should be created within the 
characterization zone.  The user may want to consider transforming the data (e.g., log transform) 
and setting a zero substitution value of some minimal value in order to have the variography and 
geostatistical simulations perform better.  Once the data set has been created, a mesh needs to be 
defined for the characterization zone.  The mesh needs to have square cells.  Next, the user 
should perform a variography analysis with the Easy Variogram routine.  
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The PAST method within BROOM utilizes a different geostatistical routine than the kriging 
methods available to the user, so therefore the kriging model does not need to be invoked in 
order to run PAST.  It uses a geostatistical simulator called SGSim.  SGSim will perform 
multiple realizations of the concentration distribution while honoring the variogram and data 
from the data set.  The user selects the PAST option and is queried for the appropriate Sample 
Set, mesh, and variogram.  Next, the user must input parameters that influence sample 
optimization.  Figure 7-44 shows the pop-up window to prescribe the necessary parameters for 
the optimization routine. 

 

Figure 7-44.  Input parameter screen for the PAST module 

The user specifies the number of samples that they wish the PAST module to produce.  The 
PAST module may not produce that many sample locations, because of the criteria for selecting 
new sample locations which may be limited by the prescription for an off-set distance between 
existing and proposed sampling points, the concentration threshold, and the probability range.  
The concentration threshold is an important parameter.  This is the concentration value around 
which the user wants to optimize the sampling locations in order to define the distribution of 
contamination that is greater than or equal to this prescribed amount.  The probability band 
determines how tight spatially the new sample locations are likely to be around the concentration 
threshold.  Once these parameters are set the user clicks the OK button.  It may take several 
minutes or more to perform the optimization due to the fact that PAST is running a Monte Carlo 
type simulation with many realizations of the SGSim geostatistical simulator.   

On the right side of the BROOM screen in the Analysis folder, PAST will have created several 
output fields.  One allows the user to display the proposed new sample locations.  Other options 
allow the user to display the mean concentration distribution, a variance distribution and a 
probability distribution.  There is also a capability to create a KML file that can be viewed in 
Google Earth.  
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8. CASE STUDY 

BROOM has been instrumental when deployed on a number of release tests facilitating data 
acquisition, data management and data analysis.  Summaries of these case studies will be 
provided in a later edition of this User’s Manual.  Several references may be of use to the user to 
see the overall use of the BROOM software on several of these tests. 

 

Knowlton, Robert and Brad Melton, 2010, “Data Collection and Analysis of the HUMBLE 
YUCCA Release Test Using the BROOM System”, Sandia Report #SAND2010-7511,Sandia 
National Laboratories, Albuquerque, New Mexico, . 
 
Joint Program Executive Office for Chemical and Biological Defense (JPEO-CBD), 2008, 
“Evaluation Report, September 2007: Indoor Field Evaluation of Sample Collection Methods 
and Strategies at Idaho National Laboratory”, May 2008, Prepared for the Department of 
Homeland Security, Science & Technology Directorate, Washington, DC 20528, and Joint 
Program Executive Office for Chemical and Biological Defense, 5203 Leesburg Pike, 
Skyline 2, Suite 1609, Falls Church, Virginia 20147, 140 p.. 
 
Joint Program Executive Office for Chemical and Biological Defense (JPEO-CBD), 2008,  
“Evaluation Report, September 2008: Indoor Field Evaluation of Sample Collection Methods 
and Strategies at Idaho National Laboratory II”, December 2008, NSTD-09-0163,  
Prepared for the Department of Homeland Security, Science & Technology Directorate, 
Washington, DC 20528, and Joint Program Executive Office for Chemical and Biological 
Defense, 5203 Leesburg Pike, Skyline 2, Suite 1609, Falls Church, Virginia 20147, 264 p.. 
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